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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Task 1 
 

Introduction  
Welcome to the "IndustrialDataBridge V7.3 Getting Started". Getting Started uses example 
projects to show you the easy operation of IDB V7.3. This "Getting Started" takes you 
through the configuration process of the IndustrialDataBridge by means of practical 
examples and enables the data transfer process during runtime using these examples.  

The included WinCC project "idb_getting_started.MCP" and IDB Getting Started project 
"IndustrialDataBridge" provides you with an environment that helps to make your first steps 
with the IndustrialDataBridge application. 

 
 

 Note 
Language 

The Getting Started examples are available only in English language. In WinCC Explorer or 
in IDB V7.3, even if you change the language, you will observe that the Getting Started 
example in WinCC Runtime will be displayed in English language. 

 

Example Project 
The example project that is provided along with this Getting Started includes 2 examples. 

 

Example 1  

The example included demonstrates the data transfer within a plant environment. This 
example deals with the data transfer of process value archive to user archive. The archived 
alarm data existing in process value archive can be further transferred to a CSV file. The 
user archive containing updated data is transferred to OPC Data Access. 

 

Example 2 

This example describes a simple production process that uses a recipe. The example deals 
with a scenario specific to a plant environment. In the example, the number of pieces 
including the recipe data - color attribute and quantity to be manufactured are retrieved from 
the database. This information will be stored in the User Archive Thereby, it is taken into 
consideration that the production process is started. After completion of production, the 
results of the production are entered in the text box fields. The information entered is stored 
in a separate User Archive. IDB application ensures data transfer wherein the results 
entered are successfully transferred to the database. 
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Task 
You will learn the following procedures: 

● The creation of project, links, performing link settings and connections in IDB CS. 

● To use the configuration in IDB Runtime required for initiating the data transfer. 

● Open Getting Started project (idb_getting_started.MCP), activate project and view Getting 
Started examples in WinCC Runtime. 

 

 
 

 Note 

The option "IndustrialDataBridge" is indicated with the abbreviation IDB in the subsequent 
chapters. 

 

Procedure 
Perform the following steps to get through Getting Started. The detailed procedure for 
performing these steps are outlined in the subsequent chapters. 

1. Create and configure the links in IDB; Export XML file. 

2. Install the WinCC project "IDB_Getting_Started". 

3. Define the computer properties in the WinCC project. 

4. Export reference XML file from WinCC project. 

5. Activate the WinCC project. 

6. Adapt the reference configuration for the WinCC project. 

7. Prepare environment for Getting Started project. 

8. Enable data transfer and start download and upload of recipe data. 

 



 

WinCC/IndustrialDataBridge Getting Started 
Getting Started, 5/2014, A5E32362955-AA 7 

 Prerequisites 2 
 

Introduction 
This chapter provides information about the hardware requirements and software 
requirements required for working with Getting Started. The prerequisites for 
IndustrialDataBridge V7.3 are provided in the IDB Information System within Chapter 
"WinCC/IndustrialDataBridge Installation Notes".  

 

The IDB Information System can be accessed by navigating to the below mentioned folder 
path. 

'C:\Program Files (x86)\Siemens\Automation\IndustrialDataBridge\Help\' 

Hardware Requirements 
The same hardware requirements apply for the Getting Started project as for other IDB 
projects. Observe the IDB V7.3 installation notes. 

Software requirements 
The same software requirements apply for the Getting Started project as for other IDB 
projects. Observe the IDB V7.3 installation notes. 

The following conditions also apply: 

● WinCC V7.3 is installed. 

● IDB V7.3 is installed. 
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 The WinCC Project 3 
3.1 Overview 

Overview 
The WinCC project "idb_getting_started" provides data that is transferred by IDB. The 
transfers are triggered by a trigger event, which is created by clicking on a button. When a 
trigger event occurs, the data is transferred in accordance with the configuration. This is 
shown in Getting Started example1 that uses process values for data transfer and example 2 
includes a recipe example that uses a simple plant production scenario. The Getting Started 
example uses "idb_getting_started.xml" as the reference configuration file. 

Structure of the WinCC project 
The WinCC project is developed exclusively for preparing an environment for the 
IndustrialDataBridge V7.3. The WinCC project therefore contains the following elements: 

● Start picture with buttons, selection fields, input fields and display fields. 

● Database in which IDB accesses the Getting Started project. 

 

The idb_getting_started.MCP file along with other resources required for WinCC project is 
provided within the "idb_getting_started" folder. These examples can be viewed in WinCC 
Runtime after the Getting Started project is activated in WinCC. 

 

The project required for working with IndustrialDataBridge CS along with the database, XML 
file can be accessed from "IndustrialDataBridge" folder available at the following location: 

For Windows 7 / Windows 8 / Windows Server 2008 / Windows Server 2012 Operating 
System: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Industri
alDataBridge\'   
 

After the installation, you need to adapt the computer properties in the WinCC project, e.g. 
computer name and path. This procedure is described in Chapter 4.2 "Preparing the 
environment for Getting Started" (Page 9). 
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3.2 Preparing the environment for Getting Started Project 

Introduction 
This chapter provides the steps for adapting the computer properties and lists the 
information specific to the steps to be performed for opening the project "idb_getting_started" 
using WinCC. Hence, after activating the project in WinCC, the WinCC Runtime displays the 
Getting Started examples. 

Prerequisites 
● The Getting Started project is installed during IDB V7.3 installation. 

● IDB Configuration System and IDB Runtime application is installed on the computer. 

● WinCC V7.3 is installed. 

Adapting the computer properties in WinCC 
To work with Getting Started project in the computer wherever WinCC is installed, it is 
required to adapt the computer properties. Follow the steps given below to adapt the 
computer properties: 

1. Start WinCC Explorer. 

2. In WinCC Explorer window, select "File" > "Open" and choose the 
idb_getting_started.MCP file from the location wherever Getting Started is installed. 

 
  Note 

Getting Started project folder 

If you have selected Getting Started project as part of IDB V7.3 installation, it will be 
installed in the following location: 

For Windows 7 / Windows 8 / Windows Server 2008 / Windows Server 2012 Operating 
System: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\'  
 

The MCP file and other Getting Started resources are available in this folder. 
 

 

3. The button "Start server locally" will be displayed. Click "Start server locally" to accept 
local computer name. 
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4. However, you need to adjust the computer properties in WinCC Explorer to reflect these 
changes. 

– In WinCC Explorer, right click on "Computer" icon and select "Properties" option. The 
"Computer List Propeties" window will be displayed. 

– The "Computer List Properties" window displays a list of computers in 'Computer List' 
field. Select the computer name and choose "Properties" button to open the 
"Computer properties" dialog window. 

– The Computer name of the local machine will be displayed in a text box next to the 
"Computer Name" field. Click the button "Use Local Computer Name" button and 
select OK. 

– Next, click OK to save the changes. This will close the "Computer List Properties" 
window. 

5. In WinCC Explorer, close the opened project and restart WinCC for the changes to take 
effect. 

6. After restarting WinCC, open the IDB project in WinCC Explorer by selecting by the 
"idb_getting_started.MCP" file. 

7. Next, activate the IDB Getting Started project "idb_getting_started" in WinCC. You will 
observe that the Getting Started examples will be started automatically in WinCC 
Runtime. 

Export XML file in WinCC 
In order for WinCC OLEDB to access WinCC User Archives, the XML file has to be exported 
from the computer that has WinCC installed. This XML Export file will be used for configuring 
WinCC OLEDB as a provider while using Process Archive or Message Archive. 
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Follow the steps given below to export XML file in WinCC: 

1. Start WinCC Explorer. 

2. Open the MCP file "idb_getting_started.MCP" and activate the project. 

3. In left hand side navigation of WinCC Explorer, right click on "IndustrialDataBridge" and 
select "Project XML Export" option to export XML file. 

4. The XML file will be exported to the following path: 

For Windows 7 / Windows 8 / Windows Server 2008 / Windows Server 2012 Operating 
System: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Indu
strialDataBridge\'Reports   

 

Result 
You have prepared the environment for working with the IndustrialDataBridge Getting 
Started examples. To access IDB Runtime using WinCC controls, refer Chapter 4.3 
"Accessing IDB Runtime using WinCC". The steps for working with the provided examples to 
enable data transfer are provided in Chapter 6 "Getting Started and Examples" (Page 19). 
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3.3 Accessing IDB Runtime using WinCC Controls 

Overview 
WinCC IDB Runtime application can be accessed using WinCC controls. This is possible by 
adding WinCC ActiveX control "IDB Runtime Control" as an OCX in Graphics Designer. This 
will help WinCC users to start IDB Runtime within their environment. 

The look and feel of IDB Runtime as an OCX is almost similar to the IDB Runtime as an 
executable. However, there are few additional changes to IDB Runtime as an OCX and 
these changes are covered in the subsequent sections. 

Accessing IDB Runtime 
To access IDB Runtime control as ActiveX control in WinCC, follow the steps given below: 

1. Start WinCC Explorer. 

2. In WinCC Explorer, double click "Graphics Designer" element from navigation window to 
open Graphics Designer. 

3. In Graphics Designer, Select File > New to create a new PDL file. 

4. Navigate to Object Palette and select controls tab. Highlight "ActiveX controls" from the 
list. 

5. Expand the ActiveX controls tree to view a list of available controls. 

 
  Note 

If you are unable to view the controls after expanding the list, right click on ActiveX 
controls and select "Add/Remove" option. The "Select OCX Controls" window is 
displayed that provides a list of available controls. Select "IDB Runtime control" and click 
OK. 

 

6. IDB Runtime control should be available as an OCX within the controls list. 

7. Drag and drop this OCX control to the container area within the PDL file window. 

8. Once this control is added to the container, save the PDL file and click Runtime control in 
Standard toolbar to activate Runtime mode. 

9. The IDB Runtime control is displayed / opened on the WinCC Runtime screen. 
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Buttons and Views 
The toolbar buttons and views in IDB Runtime as OCX are exactly same as IDB Runtime 
application. The Trace view and Status view is provided in IDB Runtime Application window. 

  
 

 Note 
Views 

The screenshots provided in chapter "Views" are not valid for IDB Runtime as an OCX 
control. While accessing IDB Runtime as an ActiveX control in WinCC, you will observe that 
the IDB Runtime menu bar will not be displayed.  

 

 Note 
"Password check" and "Trace logging" options 

The "Password check" and "Trace logging" menu items existing wthin "Options" menu in IDB 
Runtime application is available in "Password" tab and "Trace" tab as separate check boxes. 
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Options 
Select "Options" toolbar button from IDB Runtime application to access Runtime 
Configuration. The "Runtime Configuration" provides the following tabs: 

● Startup Option 

● Trace 

● Password 

● License 

● NT Service 

 
 

 Note 

Changes to the Runtime interface can be performed only if the IDB Service has been 
started. 

 

 

The options provided within each of these tabs are same as the options in IDB Runtime 
application. However, there are some additional features that are provided with IDB Runtime 
as WinCC control. These features are highlighted below: 

 

IDB Runtime Application Menus: 

The IDB Runtime Application window does not include menu based navigation. The required 
operations can be performed using the GUI buttons existing on the application toolbar. 

 

Language Option: 

The IDB Runtime application provides language support. It supports 7 languages - English, 
Spanish, German, Italian, Chinese, Japanese and French. While accessing IDB Runtime as 
OCX control on WinCC Runtime screen, the language changes when the language of 
WinCC Runtime has been changed.  

The language option of IDB runtime control is not linked to IDB Runtime application or any 
other IDB runtime control. This means that language change in IDB runtime control does not 
change the language of other controls or IDB Runtime application and viceversa. 

 

Trace Logging: 

The Trace tab is provided next to Startup option tab. This tab is displayed only after you 
have loaded the configuration file in IDB Runtime window. 

The "Trace Logging" check box is available within the "Trace" tab of Runtime Configuration 
window. Upon enabling this check box, it allows to save the trace messages generated both 
from provider and consumer side. Within the Trace tab, the "Provider log file" and 
"Consumer log file" sections provide options to specify the file name for logging the trace 
messages. At a later point of time, the trace log files can be used to view these trace 
messages. 
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Password Check: 

The "Password Check" check box is provided within "Password" tab of Runtime 
Configuration window. Once this check box is enabled, it generates a dialog box asking you 
to enter the password each time an operation is performed within each of the tabs in 
Runtime Configuration. 

 

 
 

Open dialog box: 

The Open button and Startup Option tab provides options to select configuration XML file in 
order to activate the connection during runtime. Select "Browse" button to invoke the "Open" 
dialog window. 
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In IDB Runtime as OCX, the following points are valid with respect to the actions performed 
within Open dialog box. 

● Open dialog box is opened only in Read mode. You will be able to open only an XML file. 

● Option to delete a file or folder is not provided within this dialog box. 

● Options to cut/paste a file or folder and creation of new file/folder are not available. 

● Menu pop-up on right mouse-click within the window area cannot be performed. 

● Drag and drop of file or folder within the dialog box cannot be done. 

● Options to rename file or folder using F2 key cannot be performed. 
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 The IDB Project 4 
4.1 Overview 

Overview 
The "IndustrialDataBridge" project provides you with the resources that is required for 
working with the Getting Started examples. If you have selected "Getting Started" project 
during IDB V7.3 installation, the Getting Started project will be installed at the following 
location: 

For Windows 7 / Windows 8 / Windows Server 2008 / Windows Server 2012 Operating 
System: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\'   
 

The "IndustrialDataBridge" folder includes IDBProject, XML file, Access database and other 
required resources for running the examples. The "IndustrialDataBridge" project can be 
accessed from the following folder location: 

For Windows 7 / Windows 8 / Windows Server 2008 / Windows Server 2012 Operating 
System: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Industri
alDataBridge\'   
 

This "IndustrialDataBridge" folder includes the following files: 

● IDBProject 

● Reports 

● getting_started_alarms.csv 

● idb_getting_started_configfile.xml 

● IDBGettingStarted.accdb 

 

 

The "IDBProject" folder lists the required files for viewing the project in IDB Configuration 
System. The IDBProject can be opened in IDB CS application by importing the XML file 
"idb_getting_Started_configfile.xml" provided within "IndustrialDataBridge" folder or by 
opening the .ip73 project file provided in the "IDBProject" folder. 
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 Note 
Folder Structure 

The folder structure path mentioned below is respective to Windows 7 / Windows 8 / 
Windows Server 2008 / Windows Server 2012 Operating System. Please use the folder 
locations mentioned below to navigate to the respective files or folders. 

 
• IDBProject that contains .ip73 and related files: 

'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Indu
strialDataBridge\IDBProject' 

• XML file exported from WinCC: 
'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Indu
strialDataBridge\Reports' 

• IndustrialDataBridge folder containing XML file, database and other resources: 
'C:\Users\Public/PublicDocuments\Siemens\IndustrialDataBridge\idb_getting_started\Indu
strialDataBridge\'' 

 
 

 Note 
Reports 

After exporting the XML file from WinCC project, by default the XML file will be exported 
within the 'Reports' folder. This folder exists within the "IndustrialDataBridge\Reports" folder. 
The Reports folder includes the exported XML file. 

 

 

Structure 
In IDB CS, a configuration is created and contained within a project. A project consists of link 
which inturn includes the provider, consumer, settings and connections. The definition of 
each of these items are provided below: 

● Project: A project is used to plan, organize, manage and control IDB CS configuration and 
other settings. 

● Link: A link represents an entity and contains several connections. 

● Connection: A connection represents a unique mapping between provider and consumer 
types. 
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 Getting Started and Examples 5 
5.1 Overview 

Overview 
The Getting Started project uses WinCC project, IDB project and IDB Runtime environment 
to demonstrate the data transfer behavior in IndustrialDataBridge with the help of examples. 
The projects are provided within the "idb_getting_started" folder. The Getting Started 
examples and its functionality can be viewed in WinCC Runtime environment. The example 
project uses process value example and recipe example to help you understand with the 
data transfer process using IDB V7.3 

 
 

 Note 

Use the examples only as a suggestion for realizing the Getting Started project. 
 

 

The example project helps you in getting to use IndustrialDataBridge V7.3 Configuration 
interface, create configuration file and load configuration during Runtime. It also helps to 
understand the data transfer flow with the help of a simple plant scenario. 

 

The Getting Started project 
The Getting Started project includes 2 example projects. The 2 example projects are 
explained in detail in "Getting Started Example 1" and "Getting Started Example 2" chapters.  

 

● The "Getting Started Example 1" includes an introduction to the example project and 
provides steps for configuring the project. The instructions for viewing the Example 1 
project in WinCC Runtime is also provided in this chapter. 

● The "Getting Started Example 2" includes an introduction to the example project along 
with steps for project configuration. It also includes the information about viewing 
Example 2 project in WinCC Runtime. 

 

The "IndustrialDataBridge" project includes IDBProject, XML file, Access database and other 
required resources for running the examples. The "IndustrialDataBridge" project can be 
accessed from the following folder location: 

 

For Windows 7 / Windows Server 2008 Operating System: 
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'C:\Users\Public\Public 
Documents\Siemens\IndustrialDataBridge\idb_getting_started\IndustrialDataBridge\'   
 

 

 Note 
IDB Getting Started project 

The IDB Getting Started project provided as part of the installation includes all required files 
necessary for viewing the example projects. A fully created working configuration is provided 
that can be opened in IDB CS application.  

The XML configuration file "idb_getting_started_configfile.xml" is common for both the 
example projects.  

 

 
 

 Note 
Viewing example in WinCC  

An example that includes the required fields and user interface controls can be viewed in 
WinCC Runtime environment. To view the example in WinCC, you need to open the WinCC 
project (idb_getting_started.MCP) in WinCC Explorer and activate the respective project.  

The Getting Started example screen includes a navigation control button that helps you to 
switch between Example 1 and Example 2. 

 

 
 

 Note 
Time zone 

This note is specific to the time zone settings within "WinCC OLEDB transfer options" tab. 

If the project is created in Windows XP operating system and if you import the configuration 
XML file in Windows 7 or Windows 2008 Server operating system or viceversa, it is strongly 
recommended to set the time zone accordingly. 

 

 

Working with Oracle database 
The Getting Started examples uses Microsoft Access as the database. This database is 
provided on IDB V7.3 DVD within the "IndustrialDataBridge" project folder. 

For Windows 7 / Windows Server 2008 Operating System: 

'C:\Users\Public\Public 
Documents\Siemens\IndustrialDataBridge\idb_getting_started\IndustrialDataBridge\' 
 

The entry path for IndustrialDataBridge Getting Started project "idb_getting_started" can be 
accessed from the following folder location: 



 Getting Started and Examples 
 5.1 Overview 

WinCC/IndustrialDataBridge Getting Started 
Getting Started, 5/2014, A5E32362955-AA 21 

For Windows 7 / Windows Server 2008 Operating System: 

'C:\Users\Public\Public Documents\Siemens\IndustrialDataBridge\'  
 

Installation prerequisites: 

If you wish to use Oracle as the database, you need to separately install this software in the 
computer wherever IDB V7.3 is installed. It is suggested to install Oracle 10g / 11g / 12c via 
driver "Oracle provider for OLE DB". Using other versions is basically possible but has not 
been tested. 

 

To work with Oracle 12c, you need to install Oracle client in the local computer even though 
the Oracle server edition is installed. Oracle client for 12c (32 bit) is required to be installed 
for correct working of the database in IDB V7.3. This will register 'OraOLEDB.Oracle.1' 
provider in the local computer which will then connect to the Oracle database.  

 

The following components need to be selected while installing Oracle client: 

● Optional dependencies (Oracle client) 

– Oracle provider for OLEDB 12.1.0.1.0 

 

● Oracle client dependency 

– Oracle instant client 12.1.0.1.0 

 

 

User credentials: 

After installing Oracle, you need to set the user credentials. By default, the user name 
"anonymous" is created. Under "anonymous" user, create a database. Enter the service 
name that is to be used for the database connection. Type this service name in "Server" 
field. The service name refers specifically to a configuration and can be created in the 
"tnsnames.ora" file. You will find information on the host, protocol and database in this file.  

 

1. Create a database in Oracle. 

2. Create 2 tables with 2 columns containing some key data. 

3. Next, create the tables that contains the same fields similar to the tables provided along 
with Getting Started project. 

4. Open IDB CS application and import the XML configuration file 
"idb_getting_started_configfile.xml". 

5. In Database provider, select Oracle as database type. In Server name field, enter the 
service name that was defined in Oracle. 

6. Set the user name as "anonymous" and type in the password. 
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 Note 
• In provider transfer options, the Schema name is automatically selected if you use Oracle 

as the database type. The list of tables will be provided in the "Table" field. 
• While performing connection mapping, follow the steps as described in the respective 

chapters. 
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5.2 Getting Started Example 1 

5.2.1 Introduction 

Introduction 
This Getting Started example helps you to understand the data transfer between process 
archive values and WinCC User Archive. The recipe number containing the process values 
can be generated using the buttons provided in example screen and can be transferred or 
updated in the WinCC User Archive. The archived alarm data within the Process Archive can 
be filtered based on "start date" and "end date". The alarm data based on filtered condition 
can be updated in the CSV file. A list of ingredients produced are finally transferred to the 
OPC Data Access from WinCC User Archive. This is shown in the Getting Started Example 
1. 

 

 
 

 Note 
Example project - IDBProject 

The example that includes the complete configuration provided along with Getting Started 
project contains a fully defined configuration, provider transfer options that are set along with 
connections that have already been created. 

 

 

The Getting Started example 1 helps you to understand managing the production process 
data using a recipe example and perform data transfer. This example provides the options to 
select the available recipe, transfer alarm data and send the final ingredient values to the 
consumer. 

 

Example 1 uses the following configuration available as a link. In example 1, you will create 
3 links - Send_process_values, Send_alarm_data and Receive_recipe.  

You can view this configuration in IDB CS application. 

● Process Archive (WinCC OLEDB as provider), WinCC User Archive as consumer 

● Message Archive (WinCC OLEDB as provider), CSV/TXT as consumer 

● WinCC User Archive as provider, OPC Data Access as consumer 
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● Process Archive - WinCC User Archive 

Transfers the process values (from the selected recipe) entered by user to WinCC User 
Archive by the click of a button. 

● Message Archive - CSV/TXT 

Based on "Start date" and "End date" entered in the fields, the archived alarm data within 
process archive is transferred to a CSV file by click of a button. 

● WinCC User Archive - OPC Data Access 

The individual recipe items are transferred from WinCC User Archive to OPC Data 
Access. 

 

However, in order to make you understand better, the following chapters provide information 
about the steps in detail for creating or configuring the connections. Each chapter includes a 
series of steps listed as Step 1, Step 2, Step 3 and Step 4 that guides you through the 
detailed procedure.  

● Process Archive - WinCC User Archive 

● Message Archive - CSV/TXT 

● WinCC User Archive - OPC Data Access 

 

 Note 
Important information  

If you do not wish to perform the steps given in above mentioned chapters, and you wish to 
view the example in WinCC Runtime directly, it is strongly recommended to perform the 
steps mentioned in the chapter "Viewing Example 1 in WinCC Runtime (Page 100)". 
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5.2.2 Process Archive - WinCC User Archive 

5.2.2.1 Step 1: Create Project and Link 

Introduction 
This chapter provides you with the complete steps for creating a project and link in IDB 
Configuration System application. The objective here is to create a project with 
corresponding link having WinCC OLEDB (Process Archive) as provider and WinCC User 
Archive as consumer. 

Procedure 
 

1. Open IDB Configuration and create a project by following the steps mentioned below: 

 

 
– In IDB Configuration menu, select "Project" > "Create" to create a new project. 

– In the "Create new project" dialog box, specify a project name, click [...] button and 
select the folder location wherever the project needs to be saved. 

– After entering the required information, select "Create" button. This creates a new 
project. 

2. The project name will be listed within the "Project tree". 
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3. The next step is to create a link. Follow the steps mentioned below to create a link 
between provider and consumer: 

 

 
– Right click on project name node in the tree structure and select "Add new link" option. 

After creating a project, by default a new node "Add new link" is displayed in project 
tree below project name node.  

Alternatively, you can create a new link by double clicking the "Add new link" node in 
project tree. 

– In the "Add new link" dialog that is displayed, enter a unique link name. 

– Select the provider type as WinCC OLEDB, target type as WinCC User Archive and 
click OK button. 

– The created link will be displayed below the project name in project tree. 

4. The corresponding entries - Provider, Consumer, Settings and Connections are created 
as nodes that exist below the new link in the tree structure. 

 

Result 
You have created a project that consists of a link having WinCC OLEDB as provider and 
WinCC User Archive as consumer. 
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5.2.2.2 Step 2: Configuring an Interface 

Introduction 
In this chapter, you will configure the respective provider/consumer configuration along with 
transfer behaviour settings. 

Procedure 
1. In project tree, open the Provider configuration window by double clicking the Provider 

node. 
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In Provider configuration window, click on [...] button and select the WinCC project XML 
file that you have exported from WinCC. 

 
 
  Note 

WinCC Project XML export file  

While selecting the WinCC project XML export file, please remember to choose the 
appropriate WinCC project XML file. Export the XML file from the computer that has 
WinCC installed. In WinCC Explorer, select "IndustrialDataBridge" > "Project XML Export" 
option to export the XML file. 

 

For IDB CS to be used on a WinCC station, ensure that you do not mark the "Use Single 
point of system access" for selection. 

– In "Archive configuration" section, select the WinCC station name of the selected 
provider. 

 
  Note 

WinCC Station 
• The WinCC station name is listed in the drop down list box of "WinCC station name" 

field that displays the station name wherever the WinCC XML file exists. Choose the 
WinCC station name by selecting from list. 

• The project name is automatically displayed based on the WinCC project XML file that 
is selected in "WinCC project XML file" text box. 

 
 

2. Next, double click the Consumer node in project tree to open the consumer configuration 
window. 
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  Note 

Connecting String 

In "Consumer configuration window", the "Connection string" field (at top position) 
displays the database connection string parameters after the selection of database type. 

 

 

In Consumer configuration window, perform the following settings: 

– Enter the server name and/or complete path of WinCC User Archive database. 

– Select the database name from the list that is displayed in the "Database" field. Click 
on the drop down list box to view this list. 

– If you wish to enable windows authentication automatically, select the check box "Use 
automatic windows authentication". 

– Within the section area that provides options to logon to the database, enter the user 
name and password. 

This information is required to logon to the WinCC User Archive database. 

– Click Test button to test the connection. It tests the user archive database connection 
string and verifies the selected user archive database. 
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Performing link settings 
1. In project tree, double click the Settings node to open Settings window in the work area. 

The Settings window consists of 3 tabs - Transfer options, Connection Mapping & 
Connections. 

 
 

2. Within the Transfer Options tab, you can configure the archive settings and transfer 
behavior settings for provider. 

3. In "Archive settings" section, choose the Archive type. In "Archive" field, select whether 
data is to be transferred from 'Process value archive' or from 'Alarm message archive'. 

Depending on the archive type selected, the "Process value" button and "Events" button 
will be shown in disable or enable state. 

4. Click on "Process value" button open the "Variable Filter" window. The "Events filter" 
window can be opened by clicking on the "Events" button. 

More information about configuring these filter settings is provided in "Configuration of the 
transfer behavior (Page 33)".  

5. Select the appropriate time zone in the "Time zone for consumer" field. 
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6. In "Time settings" section, enter the cycle time and choose metric (milli seconds / 
seconds / minutes / hours) by selecting the drop down list box. 

7. Next, select the type of data transfer: 

– Cyclic & Continuously 

Here, transfer time is set with a timer. This enables an hours transfer to be started for 
instance.  

The time period is defined using the last two timer times. 

– Triggered & Continuously 

In the type, the transfer time is defined using a trigger condition with OPC tags. The 
time period is defined using the last two trigger times. The IDB marks the last transfer 
time and reads the interval between two trigger times. 

–  Triggered time span 

In this type, the transfer time is defined using a trigger condition with OPC tags. The 
time period, which is read from the WinCC archive, is defined using two other OPC 
tags. 

 
 
  Note 

Transfer type 

Based on transfer type, the buttons "Time span", "Start-up behavior" and "Trigger" will be 
in enable or disable state. 
• If option "Cyclic & Continuously" or "Triggered & Continuously" is selected, both the 

"Start-up behavior" and "Trigger" buttons can be used. 
• With option "Triggered time span", only the Timespan and Trigger buttons can be 

used. 
 

8. Configure the "Trigger" and "Time span" or the "Start-up behavior" in the dialog window 
that you open by clicking the respective button. 

More information about the transfer setting capabilities and their options are provided in 
chapter "Step 3: Configuration of the transfer behavior (Page 33)". 

9. The transfer behavior settings for WinCC OLEDB as provider will be saved automatically. 

 
 
  Note 

Saving changes 

A save operation is not required every time whenever changes are performed within the 
editor window in the work area. The changes made to these settings are automatically 
saved. However, once the project is created, at any point of time, you can save the 
project by selecting the "Project" > "Save" menu option. 
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Result 
You have configured the WinCC OLEDB interface and WinCC User Archive as a consumer. 
These elements are displayed in the tree structure of the configuration interface. 
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5.2.2.3 Step 3: Configuration of Transfer Behavior 

Introduction 
This chapter highlights the key information related to WinCC OLEDB transfer setting 
capabilities and their options.  

Configuration options 
The Settings window provides user interface controls in form of drop down list box or buttons 
or radio buttons that are used to perform "Archive type settings" and "Transfer type settings". 
The configuration settings and their options existing within these dialog windows are 
explained below.  

 

Archive type settings 
There are two archive types that are supported in WinCC OLEDB as a provider. The 
"Process value" button or "Events" button is activated depending on selection of the archive 
type ("Process value archive", "Alarm message archive").  

 

● Process value archive tags 

● Alarm message archive tags 

 

Process value archive tags 

Click on "Process value" button to open "Variable filter" window that provides options to 
configure or limit the selection of process value archive tags whose value will be transferred. 
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1. In "Archive" field, select the archive for which you wish to transfer the data by choosing 

from the drop down list. 

2. The "Archive variable" section displays a list of archive variables. Select one or more tags 
from the list that is displayed at left hand side of the window. 

3. Transfer these tags to the selection field on right side with ">" or use ">>" to transfer all 
tags in the list. 

Use "<" or "<<" to delete the selected or all tags from the selection field on right side. 

4. Confirm this selection by clicking the "OK" button. 

 

Alarm message archive tags 

Click on "Events" button to open "Events filter" window that provides options to configure the 
Alarm message numbers that trigger the events. The values of individual message numbers 
or a message number range for which you want to transfer can be selected in the "Events 
filter" dialog window. 
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1. Enter a message number in the "Single Event" field text box and click "Include" button. 

This will be added to the "Chosen events" list. 

2. To specify a message number range, enter the start range and end range in "From" and 
"To" text box. Then, click "Include" button to add this event range. 

3. To exclude any event from the list, select the event within the list and click "Exclude" 
button. To clear all the events displayed within the "Chosen events" field, click "Delete 
list" button. 

4. You can select the archive language by choosing the "Archive language" field drop down 
list box. This will display the archive messages in the selected language. 

5. Once you have performed the changes, confirm this selection by clicking the "OK" button. 

 

Transfer type settings 
WinCC OLEDB supports three transfer type settings that can be selected by choosing the 
appropriate radio button. The "Time span" or "Start-up behavior" or "Trigger" buttons are 
activated depending on the radio button option you have selected within "Time settings" 
section area. Clicking on the respective button will open the dialog window. The information 
about the configuration options available within each of these dialog windows are explained 
below. 

● Time span 

● Start-up behavior 

● Trigger 
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Time span 
The "Time span" button is activated only if you have selected the radio button option 
"Triggered time span". Click "Time span" button to open the "Time span" dialog window. The 
transfer time period for selected tags is defined in this "Time span" window. The selection is 
controlled through tags of the OPC Server provided within the OPC tag browser. 

In "Time span" window, "Define update cycle" section area, the time period can be be 
defined using two different ways: 

● With a Start time and an End time (using "From" and "To" selection) 

● With a Start time and Time period (using "+/-" selection) 

 

 

Procedure 

To define the transfer time period, follow these steps: 

1. Select the tags that define the Start time by performing selection within the OPC tag 
browser. 

2. Confirm the selection by clicking the "Apply" button in the "From" line. The selected tag is 
added within the "From" text box. 

3. Define whether you want to define an End time or a period of time by selecting the 
appropriate radio button. 

4. Select the tags that define End time or the time span in the OPC tag browser. The tag 
selection will be added to the text box below "From" field. 

5. Confirm the selection by clicking the "Apply" button in the "To" line or "+/-". 

6. Click OK button after performing the required changes. 
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 Note 
Tag type 

The tags that define a time span must be of the type "VT_I4 or be present as string that can 
be converted into the type "VT_I4" by the OPC server. With the time span, the preceding 
sign determines whether the period of time is before (-) or after (+) the start time (From). 

 

 Note 
No Time period defined 

If no transfer time period is selected within the "From" and "To" or "+/-" fields, all available 
data is transferred. 

 

 

Different number format in provider and consumer types 

If the date format of the operating system deviates from the date format of the string to be 
converted, you will have to adapt the XML configuration file. Otherwise, you may experience 
conversion errors. 

Example: German operating system / 'Date' as string saved in English format.  

In this case, you will have to amend the entry <Link UID="Ref-1" Name="Linkname"> to 
<Link UID="Ref-1" Name="Linkname" LCID="1033"> in the XML configuration file.  

The attribute LCID (LocalID) indicates the format in which the string content will be saved. 
During conversion, it will be converted into the format of the operating system. The language 
name and its LCID attribute value are mentioned below:  

● English; LCID="1033" 

● German; LCID="1031" 

● French; LCID="1036" 

● Italian; LCID="1040" 

● Spanish; LCID="1034" 

● Chinese; LCID="2052" 

● Japanese; LCID="1041" 

Additional values for LCID are available under http://www.microsoft.com when you enter the 
search term "LCID". 

 

Time Zone for Data of the OPC Tags  

Define a time zone for the data of the selected OPC tags by selecting the time zone from 
drop down list box. This field "Time zone for data of OPC variables" is provided below the 
OPC tag browser and includes a drop down list box that allows you to select the time zone. 
The default setting for the time zone is the local time on the computer, on which the 
configuration was performed. If the OPC server is in another time zone, select the respective 
time zone. After performing the required changes, select OK button. 
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Start-up behavior 
The "Start-up behavior" button is activated if any one of the transfer types "Cyclic & 
continuously" or "Triggered & continuously" is selected. To open the "Start-up behavior" 
dialog window, select "Start-up behavior" button. The settings mentioned here will be used 
during start of the IndustrialDataBridge Runtime. 

 

 
 

Procedure 

To configure the behavior of first transfer, follow these steps: 

1. Choose one of the listed options provided within the "Behavior of first transfer" section 
area. 

2. If you have selected "Point in time defined by OPC tag", mark the respective tag in OPC 
tag browser and click "Apply" button. 

3. The selected tag is added within the "Point in time defined by OPC tag" text box. 
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4. Select the time zone for data transfer of OPC tags in "Time zone for data of OPC tag" 
drop down list field. 

 

5. Click "Ok" button after performing the required changes. 

 

 Note 
Tag type 

The tags that define a point in time must be of the type "VT_DATE" or be present as a string 
that can be converted into the type VT_DATE by the OPC Server. 

 

 Note 
Transfer behavior 

 
• If the "Transfer current archive values" option is selected, it transfers the current values 

(either process values or alarm messages) from the time the data transfer has started. 
• With option "Point in time defined by OPC tag" selected, the data transfer will happen 

from the date defined by OPC tag (existing in text box) till current date. 
 

 

 

Maximum time for interrupted connection 

The continuity of data transfer is guaranteed throughout IDB CS application and is also 
supported even while IDB is stopped. The IDB CS application saves the time duration of last 
transfer so that even after a restart, a continous transfer can be completed without missing 
the data. This function can be limited with the entry "Maximum time for interrupted 
connection" specified in minutes.  

This value limits the time period, from which the data will be transferred after the start or a 
connection interruption. If the value is too small, it can restrict the continuity of the data 
transfer. Enter the maximum time for interrupted connection in minutes and select OK 
button. 

 

 Note 
New or changed configuration file 

The functionality is only supported if no new or a changed configuration file is loaded in the 
IDB runtime environment. 

 

 

Time zone for Data of the OPC Tags 

You must define a time zone for the data of selected OPC tags. Define a time zone for the 
data of the selected OPC tags by selecting the time zone from drop down list box. This field 
"Time zone for data of OPC variables" is provided below the OPC tag browser and includes 
a drop down list box that allows you to select the time zone. The default setting for the time 
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zone is the local time on the computer, on which the configuration was performed. If the 
OPC server is in another time zone, select the respective time zone. 

 

 Note 
UTC Time format 

Since the data will be stored in UTC time format within the database, it is strongly 
recommended to follow or set the time zone to UTC time format. 

 

 

Trigger 
Configure the condition that triggers a data transfer for this link in the "Trigger Provider" 
dialog window. The description for this dialog window is provided in the chapter "Configuring 
a Trigger". 

 

See also 
Step 4: Configuring a Trigger (Page 41) 
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5.2.2.4 Step 4: Configuring a Trigger 

Introduction 
The "Trigger Provider" dialog window provides the OPC settings, Trigger configuration 
options and required fields that help you to configure the condition that triggers a data 
transfer. This dialog window is opened after clicking the "Trigger" button in Transfer options 
window. 

Procedure 
In "OPC settings" area, select the OPC server by clicking on the [...] button. The selection of 
the server is supported by an OPC tag browser. Next, click the button representing "tick 
mark" to accept the changes.  
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1. The browser shows the local OPC server. You can search for OPC servers in the network 

as well. 
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2. If this server is located on another computer, enter the computer name as well. The tree 

structure of OPC server is displayed within "Trigger Configuration" area. 

3. You can define an OPC item on the trigger provider, in which the success-/failure-status 
of the data transfer will be stored in the "Tag for transaction security" field. This value 
should have 1 byte signed char (e.g. VT_I1). -1 indicates the success state and 0 
indicates failure. 

4. Select the tag of the OPC server, in which this information is to be saved in the tag 
browser and click on the "Apply item" button. 

5. In "Trigger Configuration" area, select the desired tags individually and accept them by 
clicking on "Add item" each time. 

6. Use the "Remove item" button to remove the marked item. If no item is marked for 
deletion, the last item from the list is deleted if you click the "Remove item" button. Details 
about the columns in the Tag list are located in section "Tag declaration". 

 
  Note 

OPC Server 

After selection of the tags and adding them to tag list, if you switch to another OPC 
Server in OPC Settings area, a dialog window is displayed that prompts the message 
whether you wish to discard previous settings. 

 

7. In "Trigger condition" area, you can select the type of syntax with selection button "VB 
Style" or JScript Style". If a trigger condition is already created, this setting can no longer 
be changed. If the language is to be changed, the text in the "Configure Trigger 
Condition" field must be deleted. 

Details on the programming languages are located in section "Programming Languages". 

8. Create the trigger condition in the selected language. Use the Alias designations in the 
tag list for these tags. Within the text box displayed, enter the operator symbols using the 
keyboard or select them from the "Logical patterns" list box. 
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9. Test the created condition by clicking on "Validate". The trigger condition is calculated 
with the values that are entered in the "Test value" column. The result "TRUE" or 
"FALSE" is shown in a message box. 

10.If the trigger condition provides the correct result and after confirming the changes, close 
the dialog by clicking on "OK" button. 

 

Additional Information 

Tag declaration 

The columns for the tag declaration contain the following: 

● Data type: Data type of the tag. If the data type defined here does not match that on the 
server, an attempt to convert the data type is made. 

● TagID: The TagID of the tag on the OPC server 

● Alias: The alias is used for creating the trigger condition. This name must be unique and it 
must correspond with the naming conventions of the allocated programming languages. 
For more detailed information about the naming conventions, see paragraph "Valid alias 
names". 

● Confirmation value: The confirmation value is the value that the variable takes on after 
fulfilling the trigger condition and the values have been delivered to the consumer. The 
default value is "<Empty>", i.e., no confirmation value is written. 

● Test value: This value is only for testing the trigger condition and has no influence on the 
later data exchange. The test values are to be selected and changed so that they test 
whether the trigger condition delivers the expected result in all operating conditions. 

 

 Note 
Confirmation value 

The confirmation value does not give any information on whether a transaction has been 
completed successfully. 

 

 Note 
Necessity of Alias names 

The OPC ItemID is not used because it may possibly not correspond with the tag validity 
criteria, for instance, a "Point" in the tag name is not allowed. 

 

 

Valid Alias Names: 

A valid alias must correspond with the following rules: 

● Letters (no umlaut characters or ß), numbers and underscore character (_) are allowed. 

● The first character must be a letter or underscore. 

● An alias can be as long as you require. 
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● Key words from VB script or J script are not allowed. Note the respective language 
description for this. 

● Case sensitive (upper and lower case letters). 
("tag" is not the same as "Tag"). 

 

Programming languages  

You can use VBScript or JScript for the trigger condition. 

The following table shows the operator type and their symbols in both languages: 

 

 
Type VBScript JScript 
Logical NOT NOT ! 
Logical AND AND && 
Logical OR OR || 
multiplication * * 
division / / 
addition + + 
subtraction - - 
Not equal to <> != 
Less than < < 
Greater than > > 
Comparison = == 
Assignment <not possible> = 
True true or True true 
Incorrect false or False false 
string <Quotation Marks> <Quotation Marks> 

It is recommended to use these operators only. Other operators can be found in the 
language descriptions for the respective language. 

 

 Note 
Loss of Trigger Events 

The triggering depends on the update speed of the OPC server. In this case, note that data 
changes that occur within an update cycle are not considered by the trigger. That means that 
a faster change of a tag from 1 - 0 - 1 is not necessarily indicated to the trigger provider by 
the OPC server, since the 1 exists at the end again and no value change exists at the check 
time. This means that a potentially true condition is not recognized as being true and 
therefore will not lead to a data transfer. 

 
Configurations, with which the confirmation value is to set a "true" trigger condition to "false" 
again, are not secure because of the statement above. When data changes occur too 
quickly, the "true value" may stay the same or values can be left out. 
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5.2.2.5 Step 5: Connecting Tags 

Introduction 
This chapter provides the steps for performing a connection mapping between provider and 
consumer. 

Connecting Tags 
In "Settings" window, the "Connection mapping" tab includes the required fields to connect 
tags that have been sent from WinCC OLEDB interface with the selected data consumer. 
The Connection mapping tab divides the window into 3 sections.  

● WinCC OLEDB provider 

● WinCC User Archive consumer 

● Connection mapping properties 

 

The "WinCC OLEDB provider" section is displayed at top left portion of "Connection 
mapping" tab. This section provides you with required options to choose column name from 
the list of columns displayed in "Columns" section area. The "WinCC User Archive 
consumer" section exists below the provider section and includes required options to choose 
schema, table name and column names that can be mapped with the columns existing within 
WinCC OLEDB interface.  

A specific connection can be created between the WinCC OLEDB provider column and the 
column (belonging to WinCC User Archive consumer) selected in the Where statement tab. 
You can create a new connection or else modify an existing connection to apply Where 
statement on the selected column. 

 

The separator between the provider and consumer section provides a resize handle that 
helps you to resize the height of the section in order to view the fields within the section 
clearly.  

 

The "Connection mapping settings" section is displayed at right side of "Connection 
mapping" tab. This section helps you to provide a name for connection along with options for 
choosing default name for connection. The "Connect", "Modify connection", "Delete 
connection" and "Delete all connections" icons are provided at the top portion of this section. 
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1. In "WinCC OLEDB provider" section, select the column name from the list that is 
displayed within "Columns" section area. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 

3. The "Filter" field provides you the option to filter the Column names based on single 
character or first few characters of column name. 

For example, if you wish to view the column names starting with "S", type this character in 
"Filter" text box. All column names starting with "S" are displayed.  

4. Next, configure the consumer column in the WinCC User Archive consumer" tab by 
following these steps: 

– The selected table is shown in the "Table" field. Select the Schema for database if 
applicable by selecting from the drop down list in "Schema" field. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 

5. Select the Column name that you wish to connect with "WinCC OLEDB provider". The 
selected column is displayed in "Column for data value" field. 
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6. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 
 
  Note 

Data type conversion 

If the provider column does not match with consumer column, IDB CS converts the data 
type to match with data type of provider. A status window is displayed to indicate this 
change. 

 

7. Repeat steps 1 to 6 for all elements of the "WinCC OLEDB provider" that you wish to 
transfer. 

 

"Where-statement" tab 
The Where statement is required to be configured in order to select the column within the 
WinCC User Archive Consumer. The "Where-statement" tab mainly includes the "Where 
statement" configuration section and exception handling section. 

 

Follow the steps given below to perform a connection mapping: 

1. In the "WinCC OLEDB provider" section, at the (top left), select the column for which the 
where statement (WinCC User Archive consumer) needs to be applied. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 

3. In the "Where-column" field, select the column that is to be used for the Where 
Statement. If a value needs to be written to the database, this column is compared with 
the connected provider column(s). Only lines in which both values match are updated. 
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4. The behavior is defined in the "Exceptional handling" section if the selection of the 
consumer row is not unique: 

– Error Message: No consumer rows lines are overwritten and an error message is 
given as an output in the trace view of IDB Runtime. 

– Change all rows: All selected consumer rows are overwritten. 

– Using the "Enable Insert" check box, you define the behavior if a line with the key 
(primary key) does not exist. If the option is selected, a new line with the respective 
key is created. 

 
  Note 

Simultaneous utilization as Key and Consumer column 

In order to have more setting ability with the configuration, you can use a column as a 
key column and as a consumer column simultaneously. Take note that this causes the 
data in the database to be inconsistent and/or future access to the WinCC User 
Archive consumer may result in errors. 

 

5. Check the name of the connection in the "Connection mapping settings" area (right). 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

Delete settings tab 
With "WinCC User Archive consumer", you are able to delete data records from the User 
Archive. This requires connecting a provider column with a consumer column. If the delete 
condition has been met, the data record of the consumer column is deleted from the user 
archive. Delete has priority over "Insert" and "Update" actions. 

 

Follow the steps given below to perform a connection mapping: 

1. In the "WinCC OLEDB provider" section, at the (top left), select the column for which the 
values should be compared. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 

3. In "Delete settings" tab, enable the "Delete possible" check box and enter a value for the 
delete column in the "Value for delete variable" field. 

If the connecting provider column takes on this value, the respective data record that 
contains this value is deleted from the User Archive based on the Where statement. 

4. Check the name of the connection in the connection area (right). Enter a unique name for 
the connection in the Connection field or use the Default name convention. Click 
"Connect" button to confirm your entries. 
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Result 
The connections that you have created are shown in the "Connections" tab of IDB CS 
Settings window as well as within the project tree node. 
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5.2.3 Message Archive - CSV/TXT 

5.2.3.1 Step 1: Create Project and Link 

Introduction 
This chapter provides you with the complete steps for creating a project and link in IDB 
Configuration System application. The objective here is to create a project with 
corresponding link having WinCC OLEDB (Message Archive) as provider and CSV/TXT as 
consumer. 

Procedure 
 

1. Open IDB Configuration and create a project by following the steps mentioned below: 

 

 
– In IDB Configuration menu, select "Project" > "Create" to create a new project. 

– In the "Create new project" dialog box, specify a project name, click [...] button and 
select the folder location wherever the project needs to be saved. 

– After entering the required information, select "Create" button. This creates a new 
project. 

2. The project name will be listed within the "Project tree". 
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3. The next step is to create a link. Follow the steps mentioned below to create a link 
between provider and consumer: 

 

 
– Right click on project name node in the tree structure and select "Add new link" option. 

After creating a project, by default a new node "Add new link" is displayed in project 
tree below project name node.  

Alternatively, you can create a new link by double clicking the "Add new link" node in 
project tree. 

– In the "Add new link" dialog that is displayed, enter a unique link name. 

– Select the provider type as WinCC OLEDB, target type as CSV/TXT and click OK 
button. 

– The created link will be displayed below the project name in project tree. 

4. The corresponding entries - Provider, Consumer, Settings and Connections are created 
as nodes that exist below the new link in the tree structure. 

 

Result 
You have created a project that consists of a link having WinCC OLEDB as provider and 
CSV/TXT as consumer. 
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5.2.3.2 Step 2: Configuring an Interface 

Introduction 
In this chapter, you will configure the respective provider/consumer configuration along with 
transfer behaviour settings for provider. 



Getting Started and Examples  
5.2 Getting Started Example 1 

 WinCC/IndustrialDataBridge Getting Started 
54 Getting Started, 5/2014, A5E32362955-AA 

Procedure 
1. In project tree, open the Provider configuration window by double clicking the Provider 

node. 

 

 
In Provider configuration window, click on [...] button and select the WinCC project XML 
file that you have exported from WinCC. 

 
 
  Note 

WinCC Project XML export file 

While selecting the WinCC project XML export file, please remember to choose the 
appropriate WinCC project XML file. Export the XML file from the computer that has 
WinCC installed. In WinCC Explorer, select "IndustrialDataBridge" > "Project XML Export" 
option to export the XML file. 

 

2. For IDB CS to be used on a WinCC station, ensure that you do not mark the "Use Single 
point of system access" for selection. 

– In "Archive configuration" section, select the WinCC station name of the selected 
provider. 

 
  Note 

WinCC Station 

 
• The WinCC station name is listed in the drop down list box of "WinCC station name" 

field that displays the station name wherever the WinCC XML file exists. Choose the 
WinCC station name by selecting from list. 

• The project name is automatically displayed based on the WinCC project XML file that 
is selected in "WinCC project XML file" text box. 

 

3. Next, double click the Consumer node in project tree to open the consumer configuration 
window. 
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– In "CSV/TXT Configuration" field, click [...] button and select the appropriate folder by 

browsing the folder structure. 

– Click "Test" button to test the connection. The "Connection string" will be displayed in 
the Connection string text box displayed at top portion within this window. 
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Performing link settings 
 

1. In project tree, double click the Settings node to open Settings window in the work area. 
The Settings window consists of 3 tabs - Transfer options, Connection Mapping & 
Connections. 

 

 
2. Within the Transfer Options tab, you can configure the archive settings and transfer 

behavior settings for provider. 

3. In "Archive settings" section, choose the Archive type. In "Archive" field, select whether 
data is to be transferred from 'Process value archive' or from 'Alarm message archive'. 

Depending on the archive type selected, the "Process value" button and "Events" button 
will be shown in disable or enable state. 

4. Click on "Process value" button open the "Variable Filter" window. The "Events filter" 
window can be opened by clicking on the "Events" button. 

5. Select the appropriate time zone in the "Time zone for consumer" field. 

6. In "Time settings" section, enter the cycle time and choose metric (milli seconds / 
seconds / minutes / hours) by selecting the drop down list box. 
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7. Next, select the type of data transfer: 

– Cyclic & Continuously 

Here, transfer time is set with a timer. This enables an hours transfer to be started for 
instance.  

The time period is defined using the last two timer times. 

– Triggered & Continuously 

In the type, the transfer time is defined using a trigger condition with OPC tags. The 
time period is defined using the last two trigger times. The IDB marks the last transfer 
time and reads the interval between two trigger times. 

–  Triggered time span 

In this type, the transfer time is defined using a trigger condition with OPC tags. The 
time period, which is read from the WinCC archive, is defined using two other OPC 
tags. 

 
  Note 

Transfer type 

Based on transfer type, the buttons "Time span", "Start-up behavior" and "Trigger" will be 
in enable or disable state. 
• If option "Cyclic & Continuously" or "Triggered & Continuously" is selected, both the 

"Start-up behavior" and "Trigger" buttons can be used. 
• With option "Triggered time span", only the Timespan and Trigger buttons can be 

used. 
 

8. Configure the "Trigger" and "Time span" or the "Start-up behavior" in the dialog window 
that you open by clicking the respective button. 

More information about the transfer setting capabilities and their options are provided in 
chapter "Step 3: Configuration of transfer behavior (Page 58)". 

9. The transfer behavior settings for WinCC OLEDB as provider will be saved automatically. 

 
  Note 

Saving changes 

A save operation is not required every time whenever changes are performed within the 
editor window in the work area. The changes made to these settings are automatically 
saved. However, once the project is created, at any point of time, you can save the 
project by selecting the "Project" > "Save" menu option. 

 

Result 
You have configured the WinCC OLEDB interface and CSV/TXT as a consumer. These 
elements are displayed in the tree structure of the configuration interface. 

See also 
Step 3: Configuration of Transfer Behavior (Page 33) 



Getting Started and Examples  
5.2 Getting Started Example 1 

 WinCC/IndustrialDataBridge Getting Started 
58 Getting Started, 5/2014, A5E32362955-AA 

5.2.3.3 Step 3: Configuration of Transfer Behavior 

Introduction 
This chapter highlights the key information related to WinCC OLEDB transfer setting 
capabilities and their options.  

Configuration options 
The Settings window provides user interface controls in form of drop down list box or buttons 
or radio buttons that are used to perform "Archive type settings" and "Transfer type settings". 
The configuration settings and their options existing within these dialog windows are 
explained below.  

 

Archive type settings 
There are two archive types that are supported in WinCC OLEDB as a provider. The 
"Process value" button or "Events" button is activated depending on selection of the archive 
type ("Process value archive", "Alarm message archive").  

 

● Process value archive tags 

● Alarm message archive tags 

 

Process value archive tags 

Click on "Process value" button to open "Variable filter" window that provides options to 
configure or limit the selection of process value archive tags whose value will be transferred. 
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1. In "Archive" field, select the archive for which you wish to transfer the data by choosing 

from the drop down list. 

2. The "Archive variable" section displays a list of archive variables. Select one or more tags 
from the list that is displayed at left hand side of the window. 

3. Transfer these tags to the selection field on right side with ">" or use ">>" to transfer all 
tags in the list. 

Use "<" or "<<" to delete the selected or all tags from the selection field on right side. 

4. Confirm this selection by clicking the "OK" button. 

 

Alarm message archive tags 

Click on "Events" button to open "Events filter" window that provides options to configure the 
Alarm message numbers that trigger the events. The values of individual message numbers 
or a message number range for which you want to transfer can be selected in the "Events 
filter" dialog window. 
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1. Enter a message number in the "Single Event" field text box and click "Include" button. 

This will be added to the "Chosen events" list. 

2. To specify a message number range, enter the start range and end range in "From" and 
"To" text box. Then, click "Include" button to add this event range. 

3. To exclude any event from the list, select the event within the list and click "Exclude" 
button. To clear all the events displayed within the "Chosen events" field, click "Delete 
list" button. 

4. You can select the archive language by choosing the "Archive language" field drop down 
list box. This will display the archive messages in the selected language. 

5. Once you have performed the changes, confirm this selection by clicking the "OK" button. 

 

Transfer type settings 
WinCC OLEDB supports three transfer type settings that can be selected by choosing the 
appropriate radio button. The "Time span" or "Start-up behavior" or "Trigger" buttons are 
activated depending on the radio button option you have selected within "Time settings" 
section area. Clicking on the respective button will open the dialog window. The information 
about the configuration options available within each of these dialog windows are explained 
below. 

● Time span 

● Start-up behavior 

● Trigger 
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Time span 
The "Time span" button is activated only if you have selected the radio button option 
"Triggered time span". Click "Time span" button to open the "Time span" dialog window. The 
transfer time period for selected tags is defined in this "Time span" window. The selection is 
controlled through tags of the OPC Server provided within the OPC tag browser. 

In "Time span" window, "Define update cycle" section area, the time period can be be 
defined using two different ways: 

● With a Start time and an End time (using "From" and "To" selection) 

● With a Start time and Time period (using "+/-" selection) 

 

 

 

Procedure 

To define the transfer time period, follow these steps: 

1. Select the tags that define the Start time by performing selection within the OPC tag 
browser. 

2. Confirm the selection by clicking the "Apply" button in the "From" line. The selected tag is 
added within the "From" text box. 
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3. Define whether you want to define an End time or a period of time by selecting the 
appropriate radio button. 

4. Select the tags that define End time or the time span in the OPC tag browser. The tag 
selection will be added to the text box below "From" field. 

5. Confirm the selection by clicking the "Apply" button in the "To" line or "+/-". 

6. Click OK button after performing the required changes. 

 

 Note 
Tag type 

The tags that define a time span must be of the type "VT_I4 or be present as string that can 
be converted into the type "VT_I4" by the OPC server. With the time span, the preceding 
sign determines whether the period of time is before (-) or after (+) the start time (From). 

 

 Note 
No Time period defined 

If no transfer time period is selected within the "From" and "To" or "+/-" fields, all available 
data is transferred. 

 

 

Different number format in provider and consumer types 

If the date format of the operating system deviates from the date format of the string to be 
converted, you will have to adapt the XML configuration file. Otherwise, you may experience 
conversion errors. 

Example: German operating system / 'Date' as string saved in English format.  

In this case, you will have to amend the entry <Link UID="Ref-1" Name="Linkname"> to 
<Link UID="Ref-1" Name="Linkname" LCID="1033"> in the XML configuration file.  

The attribute LCID (LocalID) indicates the format in which the string content will be saved. 
During conversion, it will be converted into the format of the operating system. The language 
name and its LCID attribute value are mentioned below:  

● English; LCID="1033" 

● German; LCID="1031" 

● French; LCID="1036" 

● Italian; LCID="1040" 

● Spanish; LCID="1034" 

● Chinese; LCID="2052" 

● Japanese; LCID="1041" 

Additional values for LCID are available under http://www.microsoft.com 
(http://www.microsoft.com) when you enter the search term "LCID". 

 

http://www.microsoft.com/
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Time Zone for Data of the OPC Tags  

Define a time zone for the data of the selected OPC tags by selecting the time zone from 
drop down list box. This field "Time zone for data of OPC variables" is provided below the 
OPC tag browser and includes a drop down list box that allows you to select the time zone. 
The default setting for the time zone is the local time on the computer, on which the 
configuration was performed. If the OPC server is in another time zone, select the respective 
time zone. After performing the required changes, select OK button. 

 

Start-up behavior 
The "Start-up behavior" button is activated if any one of the transfer types "Cyclic & 
continuously" or "Triggered & continuously" is selected. To open the "Start-up behavior" 
dialog window, select "Start-up behavior" button. The settings mentioned here will be used 
during start of the IndustrialDataBridge Runtime. 
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Procedure 

To configure the behavior of first transfer, follow these steps: 

1. Choose one of the listed options provided within the "Behavior of first transfer" section 
area. 

2. If you have selected "Point in time defined by OPC tag", mark the respective tag in OPC 
tag browser and click "Apply" button. 

3. The selected tag is added within the "Point in time defined by OPC tag" text box. 

4. Select the time zone for data transfer of OPC tags in "Time zone for data of OPC tag" 
drop down list field. 

 

5. Click "Ok" button after performing the required changes. 

 

 Note 
Tag type 

The tags that define a point in time must be of the type "VT_DATE" or be present as a string 
that can be converted into the type VT_DATE by the OPC Server. 

 

 Note 
Transfer behavior 

 
• If the "Transfer current archive values" option is selected, it transfers the current values 

(either process values or alarm messages) from the time the data transfer has started. 
• With option "Point in time defined by OPC tag" selected, the data transfer will happen 

from the date defined by OPC tag (existing in text box) till current date. 
 

 

 

Maximum time for interrupted connection 

The continuity of data transfer is guaranteed throughout IDB CS application and is also 
supported even while IDB is stopped. The IDB CS application saves the time duration of last 
transfer so that even after a restart, a continuous transfer can be completed without missing 
the data. This function can be limited with the entry "Maximum time for interrupted 
connection" specified in minutes.  
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This value limits the time period, from which the data will be transferred after the start or a 
connection interruption. If the value is too small, it can restrict the continuity of the data 
transfer. Enter the maximum time for interrupted connection in minutes and select OK 
button. 

 

 Note 
New or changed configuration file 

The functionality is only supported if no new or a changed configuration file is loaded in the 
IDB runtime environment. 

 

 

Time zone for Data of the OPC Tags 

You must define a time zone for the data of selected OPC tags. Define a time zone for the 
data of the selected OPC tags by selecting the time zone from drop down list box. This field 
"Time zone for data of OPC variables" is provided below the OPC tag browser and includes 
a drop down list box that allows you to select the time zone. The default setting for the time 
zone is the local time on the computer, on which the configuration was performed. If the 
OPC server is in another time zone, select the respective time zone. 

 

 Note 
UTC Time format 

Since the data will be stored in UTC time format within the database, it is strongly 
recommended to follow or set the time zone to UTC time format. 

 

 

Trigger 
Configure the condition that triggers a data transfer for this link in the "Trigger Provider" 
dialog window. The description for this dialog window is provided in the chapter "Configuring 
a Trigger (Page 66)". 
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5.2.3.4 Step 4: Configuring a Trigger 

Introduction 
The "Trigger Provider" dialog window provides the OPC settings, Trigger configuration 
options and required fields that help you to configure the condition that triggers a data 
transfer. This dialog window is opened after clicking the "Trigger" button in Transfer options 
window. 

Procedure 
In "OPC settings" area, select the OPC server by clicking on the [...] button. The selection of 
the server is supported by an OPC tag browser. Next, click the button representing "tick 
mark" to accept the changes.  
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1. The browser shows the local OPC server. You can search for OPC servers in the network 

as well. 
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2. If this server is located on another computer, enter the computer name as well. The tree 

structure of OPC server is displayed within "Trigger Configuration" area. 

3. You can define an OPC item on the trigger provider, in which the success-/failure-status 
of the data transfer will be stored in the "Tag for transaction security" field. This value 
should have 1 byte signed char (e.g. VT_I1). -1 indicates the success state and 0 
indicates failure. 

4. Select the tag of the OPC server, in which this information is to be saved in the tag 
browser and click on the "Apply item" button. 

5. In "Trigger Configuration" area, select the desired tags individually and accept them by 
clicking on "Add item" each time. 

6. Use the "Remove item" button to remove the marked item. If no item is marked for 
deletion, the last item from the list is deleted if you click the "Remove item" button. Details 
about the columns in the Tag list are located in section "Tag declaration". 

 
  Note 

OPC Server 

After selection of the tags and adding them to tag list, if you switch to another OPC 
Server in OPC Settings area, a dialog window is displayed that prompts the message 
whether you wish to discard previous settings. 

 

7. In "Trigger condition" area, you can select the type of syntax with selection button "VB 
Style" or JScript Style". If a trigger condition is already created, this setting can no longer 
be changed. If the language is to be changed, the text in the "Configure Trigger 
Condition" field must be deleted. 

Details on the programming languages are located in section "Programming Languages". 

8. Create the trigger condition in the selected language. Use the Alias designations in the 
tag list for these tags. Within the text box displayed, enter the operator symbols using the 
keyboard or select them from the "Logical patterns" list box. 
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9. Test the created condition by clicking on "Validate". The trigger condition is calculated 
with the values that are entered in the "Test value" column. The result "TRUE" or 
"FALSE" is shown in a message box. 

10.If the trigger condition provides the correct result and after confirming the changes, close 
the dialog by clicking on "OK" button. 

 

Additional Information 

Tag declaration 

The columns for the tag declaration contain the following: 

● Data type: Data type of the tag. If the data type defined here does not match that on the 
server, an attempt to convert the data type is made. 

● TagID: The TagID of the tag on the OPC server 

● Alias: The alias is used for creating the trigger condition. This name must be unique and it 
must correspond with the naming conventions of the allocated programming languages. 
For more detailed information about the naming conventions, see paragraph "Valid alias 
names". 

● Confirmation value: The confirmation value is the value that the variable takes on after 
fulfilling the trigger condition and the values have been delivered to the consumer. The 
default value is "<Empty>", i.e., no confirmation value is written. 

● Test value: This value is only for testing the trigger condition and has no influence on the 
later data exchange. The test values are to be selected and changed so that they test 
whether the trigger condition delivers the expected result in all operating conditions. 

 

 Note 
Confirmation value 

The confirmation value does not give any information on whether a transaction has been 
completed successfully. 

 

 Note 
Necessity of Alias names 

The OPC ItemID is not used because it may possibly not correspond with the tag validity 
criteria, for instance, a "Point" in the tag name is not allowed. 

 

 

Valid Alias Names: 

A valid alias must correspond with the following rules: 

● Letters (no umlaut characters or ß), numbers and underscore character (_) are allowed. 

● The first character must be a letter or underscore. 

● An alias can be as long as you require. 
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● Key words from VB script or J script are not allowed. Note the respective language 
description for this. 

● Case sensitive (upper and lower case letters). 
("tag" is not the same as "Tag"). 

 

Programming languages  

You can use VBScript or JScript for the trigger condition. 

The following table shows the operator type and their symbols in both languages: 

 

 
Type VBScript JScript 
Logical NOT NOT ! 
Logical AND AND && 
Logical OR OR || 
multiplication * * 
division / / 
addition + + 
subtraction - - 
Not equal to <> != 
Less than < < 
Greater than > > 
Comparison = == 
Assignment <not possible> = 
True true or True true 
Incorrect false or False false 
string <Quotation Marks> <Quotation Marks> 

It is recommended to use these operators only. Other operators can be found in the 
language descriptions for the respective language. 

 

 Note 
Loss of Trigger Events 

The triggering depends on the update speed of the OPC server. In this case, note that data 
changes that occur within an update cycle are not considered by the trigger. That means that 
a faster change of a tag from 1 - 0 - 1 is not necessarily indicated to the trigger provider by 
the OPC server, since the 1 exists at the end again and no value change exists at the check 
time. This means that a potentially true condition is not recognized as being true and 
therefore will not lead to a data transfer. 

 
Configurations, with which the confirmation value is to set a "true" trigger condition to "false" 
again, are not secure because of the statement above. When data changes occur too 
quickly, the "true value" may stay the same or values can be left out. 
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5.2.3.5 Step 5: Connecting Tags 

Introduction 
This chapter provides the steps for performing a connection mapping between provider and 
consumer. 

Connecting tags 
In "Settings" window, the "Connection mapping" tab includes the required fields to connect 
tags that have been sent from WinCC OLEDB interface with the selected data consumer. 
The Connection mapping tab divides the window into 3 sections.  

● WinCC OLEDB provider 

● CSV/TXT consumer 

● Connection mapping properties 

 

WinCC OLEDB provider 

The "WinCC OLEDB provider" section is displayed at top left portion of "Connection 
mapping" tab. This section provides you with required options to choose column name from 
the list of columns displayed in "Columns" section area.  

The separator between the provider and consumer section provides a resize handle that 
helps you to resize the height of the section in order to view the fields within the section 
clearly.  
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The "Connection mapping settings" section is displayed at right side of "Connection 
mapping" tab. This section helps you to provide a name for connection along with options for 
choosing default name for connection. The "Connect", "Modify connection", "Delete 
connection" and "Delete all connections" icons are provided at the top portion of this section. 

 

CSV/TXT consumer 

The CSV/TXT consumer is displayed below the provider section and includes options for 
selecting the column within CSV/TXT file. It also provides options to create new CSV/TXT 
file with required columns.  

In the consumer section, "Maximum entry configuration" tab is displayed next to the 
"CSV/TXT consumer" tab. The "Maximum entry configuration" tab provides the required 
fields for archive file name generation. 

 

The "CSV/TXT consumer" tab displays the "CSV/TXT" and "Columns" area.  

The "CSV/TXT" area includes options to select the CSV/TXT file. The corresponding column 
names will be listed in the "Columns" area upon selection of this CSV, TXT file. CSV, TXT 
supports only one data type "OLE Automation string (VT_BSTR)". This data type is selected 
by default after the selection of respective column name within the "Columns" area. 

 

Follow the steps provided below to select the CSV/TXT file and choose the required column 
name that needs to be mapped: 
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1. Within "CSV/TXT" area, the "CSV filename" list box is provided that displays a list of CSV 
or TXT files. Click the drop down arrow of "CSV filename" field and select the appropriate 
CSV file. 

2. If the CSV/TXT file does not exist in the list, select "New CSV file" button. The "CSV 
Creator" dialog box opens thus providing options to create a new CSV file. 

 

 
In the "CSV creator" dialog window, select "Add" button to create a column entry with 
default name. To define a custom name for the column, enter the column name in 
"Column name" field provided at top portion of this window. The created columns are 
displayed within the "Columns" text area. The "UP" and "DOWN" buttons allows in 
changing the column sequence. 

 
 
  Note 

The keyword "ID" written in capital letters should not be used for creating the first column 
name of CSV file. If "ID" is given as column name for the first column, then a warning 
message is displayed upon double clicking the CSV file. CSV files do not support this 
behavior. 

 

3. Enter a file name in the "Filename" text box followed by file extension and select "Create" 
button to create the CSV file. The new CSV file will be now available in the file list. 

If the file that is selected within the list is of type UTF-8 format, the check box "UTF-8" will 
be automatically enabled. If the file is of ANSI format, the check box remains unchecked. 
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4. In "CSV/TXT consumer" tab, select the CSV file that is displayed in the "CSV filename" 
field list box. The "Columns" area displays the "column name" along with its associated 
"Data type". 

5. In "Columns" area, select the column name from the list. The selected column name is 
displayed in "Column for data value" field and the corresponding data type is selected 
and displayed in "Data type" field. 

6. To add new columns to the selected CSV file, navigate to bottom portion of the column 
list and double click the row that contains the text "<Add new column>". 

 

 
7. The "Column name" dialog box is displayed that allows you to enter the new column 

name. Enter a name for the new column and click "Create" button. 

The new column will be listed within the list of column names. You can create any 
number of columns by repeating Steps 6 & 7. 

8. If the column name has "Date/time" data type, the time stamp can be written to the 
specific column. In this case, select the respective "Active" check box and select the 
column in "Column for timestamp" field list box. 

9. The "Filter" field provides you the option to filter the Column names based on single 
character or first few characters of column name. 

For example, if you wish to view the column names starting with "S", type this character in 
"Filter" text box. All column names starting with "S" are displayed. 

 

Maximum Entry Configuration: 

The "Maximum Entry Configuration" tab provides options to archive the data. Continuous 
archiving can be handled or else options to archive once the maximum entries are reached 
are also supported. This also provides support for archive file name generation wherein 
several options are provided for selection that is used for generating the archive file name. 
The "Archive path" field allows for selecting the desired archive path. 
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Follow the steps given below to perform these archive settings: 

1. Select the check box "Archive File at Maximum Entry" and specify a value in "Max. 
entries" text box. If this value is set to zero, you can write any number of lines into the file. 

 
 
  Note 

• By default, the "Max. entries" field displays the value as 0. However, this value can be 
modified. 

• It is important to ensure that "Max. entries" field should not be left blank. 
• If "Max. entries" is set to a value less than zero or negative value entered or if the field 

is blank, an error message "Value should be greater than or equal to zero" is 
displayed. 

• The maximum value for Max. entries in CSV/TXT is 2147483647. Any value entered 
above this range will not be accepted and displays an error message as "Type 
conversion failed". 

 
  Note 

• If this check box "Archive File at Maximum Entry" is unchecked, the Archive File Name 
Generation and other file name selection options within this tab will be in disable state. 

 

2. In "Archive File Name Generation" area, options are provided for file name generation 
with respect to the archive file. Select any one of the following options by selecting the 
radio button. 

– Use current date and time 

– Use current date and serial number 

– Use serial number 

3. Next, specify the Archive path in the text box provided. You can either enter the full path 
name in the text box or select the path using "..." button. If you provide the path in archive 
path text box, archived CSV files are generated at this path. By default, this text box has 
the same path where the base CSV file is present. 
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4. The "Use Dedicated File Name" check box allows for options to specify a dedicated file 
name in combination with a serial number and date or date and time or serial number. If 
this checkbox is unchecked, then the base CSV filename will be used for archiving. 

5. The "Select filename type" field provides options to select custom file name. 

– To use custom file name, select filename type as "Use custom filename" and enter the 
custom file name in "Custom file name" text box. 

 
 

 Note 
Serial number 

A range of 1 - 999999999 is supported for the serial number. During runtime, if the serial 
number exceeds this maximum value, a trace log will be automatically created when this 
value is reached. Once this upper limit is reached, IDB will not create any new archive file. 
The same file will be updated continuously during data transfer. 

 

 
 

 Note 

Upon selection of "Use Dedicated File Name" check box, the 'Select Filename Type' 
provides an option "Use custom filename" within the drop down list. Select this option and 
enter the customer filename in "Custom filename" text box. 

The option "Use Filename from WinCC Tag" is provided only with providers that supports 
Tags.  

 

 

Connection Mapping 

To establish connection between the provider and consumer, a data column mapping is 
required to be performed. Defining a connection name is the first step towards the setup of a 
connection. The Connection window displays "Default connection name" options in order to 
specify a name for default connection. Connect, Modify connection, Delete connection and 
Delete all connections icons are provided below the "Default connection name" section. 
These buttons help in order to work with the connections. 

 
 

 Note 
Modify connection 

To modify an existing connection, perform the required changes and then select "Modify" 
button. The changes can be observed within the Connection window only after selecting the 
"Modify" button. 
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Follow these steps to perform column mapping between provider and consumer: 

 

1. Select a tag name from "WinCC OLEDB provider" and choose the column name from 
CSV/TXT consumer" column that needs to be mapped. Click "Connect" button. 

2. If there is a data mismatch between the provider and consumer columns, IDB CS will 
modify the data type to VT_BSTR data type and displays the message "The provider data 
type was changed to fit the consumer type". Next, click OK. 

3. Repeat steps 1 & 2 for all elements of the provider that you wish to transfer. A connection 
is created for each of the column values in provider and consumer. 

4. To use dedicated file name, enable the "Use dedicated filename" check box and select 
"Use custom filename" in "Select filename type" field. 

Enter custom filename in "Custom filename" text box. 

5. Specify a connection name for this connection from the options provided within the 
"Default Connection name" area and click "Connect" button. 

 
 
  Note 

Data type conversion  

If the provider column does not match with consumer column, IDB CS converts the data 
type to match with data type of provider. A status window is displayed to indicate this 
change. 

 

6. The connection name including the provider and consumer data values will be displayed 
below the Connect button. 

7. The list of connections will be displayed in the Connections tab. 

 

 Note 
Column for time stamp 

The time stamp must be assigned before connecting the first tags. Afterwards, adding or 
changing is only possible if all items are deleted, the dialog is closed and reopened again. 
The time stamp is generated from the local time, if new data is transferred from the provider. 

 

 

Result 
The connections that you have created are shown in the "Connections" tab of IDB CS 
"Settings" window as well as within the project tree node. 
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5.2.4 WinCC User Archive - OPC Data Access 

5.2.4.1 Step 1: Create Project and Link 

Introduction 
This chapter provides you with the complete steps for creating a project and link in IDB 
Configuration System application. The objective here is to create a project with 
corresponding link having WinCC User Archive as provider and OPC DataAccess as 
consumer.  

Procedure 
 

1. Open IDB Configuration and create a project by following the steps mentioned below: 

 

 
– In IDB Configuration menu, select "Project" > "Create" to create a new project. 

– In the "Create new project" dialog box, specify a project name, click [...] button and 
select the folder location wherever the project needs to be saved. 

– After entering the required information, select "Create" button. This creates a new 
project. 

2. The project name will be listed within the "Project tree". 
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3. The next step is to create a link. Follow the steps mentioned below to create a link 
between provider and consumer: 

– Right click on project name node in the tree structure and select "Add new link" option. 

After creating a project, by default a new node "Add new link" is displayed in project 
tree below project name node.  

Alternatively, you can create a new link by double clicking the "Add new link" node in 
project tree. 

– In the "Add new link" dialog that is displayed, enter a unique link name. 

– Select the provider type as WinCC User Archive, consumer type as OPC DataAccess 
and click OK button. 

– The created link will be displayed below the project name in project tree. 

4. The corresponding entries - Provider, Consumer, Settings and Connections are created 
as nodes that exist below the new link in the tree structure. 

 

 
 

Result 
You have created a project that consists of a link having WinCC User Archive as provider 
and OPC DataAccess as consumer. 
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5.2.4.2 Step 2: Configuring an Interface 

Introduction 
In this chapter, you will configure the respective provider/consumer configuration along with 
transfer behaviour settings. 
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Procedure 
1. In project tree, open the Provider configuration window by double clicking the Provider 

node. 

 

 
 
  Note 

Connection String 

In "WinCC User Archive provider configuration" window, the "Connection string" field (at 
top portion) displays the database connection string parameters after the selection of 
database type. 

 

2. In Provider configuration window, perform the following settings: 

– Enter the server name and/or complete path of WinCC User Archive database. 

– Select the database name from the list that is displayed in the "Database" field. Click 
on the drop down list box to view this list. 

– If you wish to enable windows authentication automatically, select the check box "Use 
automatic windows authentication". 

– Within the section area that provides options to logon to the database, enter the user 
name and password. 

This information is required to logon to the WinCC User Archive database. 

– Click Test button to test the connection. Next, double click the Consumer node in 
project tree. 
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  Note 
User Archive 

Ensure that you enter the complete path of the computer wherever WinCC has been 
installed. If the path name is not valid, then the "Database" field will not display any 
tables. Also, it is important to verify that the user archive table contains one or more rows 
of data. 

 

3. In Consumer configuration window, perform the following settings: 
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"OPC DataAccess configuration" section 

– Browse for OPC Server by clicking the [...] button and select the OPC Server. 

 The selection of server is supported by an OPC tag browser. 

– The node name is automatically displayed in "Node name" text box after selection of 
the OPC Server. 

 
  Note 

Node name 

For local OPC Server, the node name will display as "local host". In case of remote OPC 
Server, the remote computer name will be displayed after selection of OPC Server on the 
remote computer. This node name is required for searching the OPC Server from the 
remote computer. 

The OPC tag browser does not display any content if node name is invalid. 
 
  Note 

The "OPC Server" and "Node name" fields are provided as editable fields. If the 
information about OPC Server name and node name is known, you can directly enter the 
information in the "OPC Server" and "Node name" fields. If the node name / OPC Server 
name is invalid, there will be no content displayed within the OPC tag browser.  

 

 

"Configuration for bad quality item" section 

– In the "Configure a Variable number of transaction errors" field, click on [...] button and 
select a tag in OPC tag browser. Next, click the button representing "tick mark" to 
accept the changes. The amount of tags with errors is written with provider tags with 
QUALITY=BAD. 

– Choose the specific data type by selecting from the drop down list box. 

 
 
  Note 

OPC tags 

Selection of the tag in OPC tag browser displays the corresponding data type in 
"Datatype" field. However, if you know the tag name, enter the tag name in "Configure a 
Variable for number of transaction errors" field and select the data type in "Datatype" field 
by selecting from the list.  

 

 

"Asynchronous transfer configuration" section 

– Enable the check box option "Write asynchronous" for asynchronous writing. 

– Enter the permitted number of maximum outstanding write transactions in the text box. 
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  Note 
Asynchronous transfer 

If the "Write asynchronous" check box is enabled, a default value of 10 is set and will be 
displayed within the "Maximum number of outstanding write transaction" text box. When 
this check box is disabled, the value will be reset to 0. You can type a value in this text 
box ranging from 1 - 40. If the value entered in this text box is not within the range, then 
an error message is displayed.  

 
  Note 

Asynchronous writing 

The Asynchronous transfer configuration is useful to ensure the correctness of the actual 
data transfer that is happening. 

Example: If you have configured the "Maximum number of outstanding write transaction" 
as 15 and if the data transfer is not happening correctly, after the failure of 15th 
transaction, a warning message will be displayed in the IDB Runtime Trace view. 

 

Performing link settings 
1. In project tree, double click the Settings node to open Settings window in the work area. 

The Settings window consists of 3 tabs - Transfer options, Connection Mapping & 
Connections. 
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2. Within the Transfer options tab, you can configure the transfer behavior settings for 
provider. 

– Select the Table name by selecting from the drop down list. 

 
 
  Note 

Schema 
• In WinCC User Archive, a default schema is selected automatically in the Transfer 

options tab. 
 

 

3. Click "Event" button to configure the trigger provider settings. The "Trigger provider" will 
be opened. 

The description of the "Trigger provider" window is provided in chapter "Configuring a 
Trigger (Page 86)" 

4. The transfer behavior settings for provider will be saved automatically. 

Result 
You have configured the WinCC User Archive interface and OPC DataAccess as consumer 
including the provider transfer options. These elements are displayed in the tree structure of 
the IDB configuration interface. 
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5.2.4.3 Step 3: Configuring a Trigger 

Introduction 
The "Trigger Provider" dialog window provides the OPC settings, Trigger configuration 
options and required fields that help you to configure the condition that triggers a data 
transfer. This dialog window is opened after clicking the "Trigger" button in Transfer options 
window. 

 
 

 Note 
OPC tag browser 

The OPC tags within "Trigger configuration" section will only be displayed if you have 
already selected the name of the OPC Server. 
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Procedure 
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1. In "OPC settings" area, select the OPC server by clicking on the [...] button. The selection 
of the server is supported by an OPC tag browser. Next, click the button representing 
"tick mark" to accept the changes. 

 

 
2. If this server is located on another computer, enter the computer name as well. The tree 

structure of OPC server is displayed within "Trigger Configuration" area. 

 
 
  Note 

Node name 

For local OPC Server, the node name will display as "local host". In case of remote OPC 
Server, the remote computer name will be displayed after selection of OPC Server on the 
remote computer. This "Node name" is required for searching the OPC Server from the 
remote computer. 

The OPC tag browser does not display any content if node name is invalid. 
 
  Note 

The "OPC Server" and "Node name" fields are provided as editable fields.  

If the information about OPC Server name and node name is known, you can directly 
enter the information in the "OPC Server" and "Node name" fields. If the node name / 
OPC Server name is invalid, there will be no content displayed within the OPC tag 
browser.  

 

 

3. You can define an OPC tag on the trigger source, in which the success-/failure-status of 
the data transfer will be stored in the "Tag for transaction security" field. This value should 
have 1 byte signed char (e.g. VT_I1). -1 indicates the success state and 0 indicates 
failure. 

Select the tag of the OPC server, in which this information is to be saved in the tag 
browser and click on the "Apply item" button. 
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4. In "Trigger Configuration" area, select the desired tags individually and accept them by 
clicking on "Add item" each time. 

The selected tags are shown in the Tag list below.  

5. Use the "Remove item" button to remove the marked item. If no item is marked for 
deletion, the last item from the list is deleted if you click the "Remove item" button. Details 
about the columns in the Tag list are located in section "Tag declaration". 

 
 
  Note 

OPC Server 

After selection of the tags and adding them to tag list, if you switch to another OPC 
Server in OPC Settings area, a dialog window is displayed that prompts the message 
whether you wish to discard previous settings. 

 

6. In "Trigger condition" area, you can select the type of syntax with selection button "VB 
Style" or JScript Style". If a trigger condition is already created, this setting can no longer 
be changed. If the language is to be changed, the text in the "Configure Trigger 
Condition" field must be deleted. 

Details on the programming languages are located in section "Programming Languages". 

7. Create the trigger condition in the selected language. Use the Alias designations in the 
tag list for these tags. Within the text box displayed, enter the operator symbols using the 
keyboard or select them from the "Logical patterns" list box. 

8. Test the created condition by clicking on "Validate". The trigger condition is calculated 
with the values that are entered in the "Test value" column. The result "TRUE" or 
"FALSE" is shown in a message box. 

9. If the trigger condition provides the correct result and after confirming the changes, close 
the dialog by clicking on "OK" button. 

Additional Information 

Tag declaration 

The columns for the tag declaration contain the following: 

 

● Data type: Data type of the tag. If the data type defined here does not match that on the 
server, an attempt to convert the data type is made. 

● TagID: The TagID of the tag on the OPC server 

● Alias: The alias is used for creating the trigger condition. This name must be unique and it 
must correspond with the naming conventions of the allocated programming languages. 
For more detailed information about the naming conventions, see paragraph "Valid alias 
names". 
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● Confirmation value: The confirmation value is the value that the variable takes on after 
fulfilling the trigger condition and the values have been delivered to the consumer. The 
default value is "<Empty>", i.e., no confirmation value is written. 

● Test value: This value is only for testing the trigger condition and has no influence on the 
later data exchange. The test values are to be selected and changed so that they test 
whether the trigger condition delivers the expected result in all operating conditions. 

 

 Note 
Confirmation value 

The confirmation value does not give any information on whether a transaction has been 
completed successfully. 

 

 Note 
Necessity of Alias names 

The OPC ItemID is not used because it may possibly not correspond with the tag validity 
criteria, for instance, a "Point" in the tag name is not allowed. 

 

 

Valid Alias names 

A valid alias must correspond with the following rules: 

● Letters (no umlaut characters or ß), numbers and underscore character (_) are allowed. 

● The first character must be a letter or underscore. 

● An alias can be as long as you require. 

● Key words from VB script or J script are not allowed. Note the respective language 
description for this. 

● Case sensitive (upper and lower case letters). 
("tag" is not the same as "Tag"). 

 

Programming languages  

You can use VBScript or JScript for the trigger condition. 

The following table shows the operator type and their symbols in both languages: 

 

 
Type VBScript JScript 
Logical NOT NOT ! 
Logical AND AND && 
Logical OR OR || 
multiplication * * 
division / / 
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Type VBScript JScript 
addition + + 
subtraction - - 
Not equal to <> != 
Less than < < 
Greater than > > 
Comparison = == 
Assignment <not possible> = 
True true or True true 
Incorrect false or False false 
string <Quotation Marks> <Quotation Marks> 

It is recommended to use these operators only. Other operators can be found in the 
language descriptions for the respective language 

 
 

 Note 
Loss of Trigger Events 

The triggering depends on the update speed of the OPC server. In this case, note that data 
changes that occur within an update cycle are not considered by the trigger. That means that 
a faster change of a tag from 1 - 0 - 1 is not necessarily indicated to the trigger provider by 
the OPC server, since the 1 exists at the end again and no value change exists at the check 
time. This means that a potentially true condition is not recognized as being true and 
therefore will not lead to a data transfer. 

 
Configurations, with which the confirmation value is to set a "true" trigger condition to "false" 
again, are not secure because of the statement above. When data changes occur too 
quickly, the "true value" may stay the same or values can be left out. 
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5.2.4.4 Step 4: Connecting Tags 

Introduction 
This chapter provides the steps for performing connection mapping between provider and 
consumer. 

Connecting Tags 
In "Settings" window, the "Connection mapping" tab includes the required fields to connect 
tags that have been sent from the WinCC User Archives interface with the selected 
consumer. The Connection mapping tab divides the window into 3 sections 

● WinCC User Archive Provider 

● OPC Data Access consumer 

● Connection mapping settings 

 
The "WinCC User Archive Provider" section is displayed at top left portion of "Connection 
mapping" tab. This section provides you with required options to choose schema, table name 
and column name(s) to be mapped. The "OPC Data Access consumer" section is displayed 
at bottom left portion of "Connection mapping" tab. This section provides you with required 
options to choose the tag name from the list of OPC tags in the OPC tag browser that can be 
mapped with WinCC User Archive provider column. 
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The separator between the provider and consumer section provides a resize handle that 
helps you to resize the height of the section in order to view the fields within the section 
clearly.  

 

The "Connection mapping settings" section is displayed at right side of "Connection 
mapping" tab. This section helps you to provide a name for connection along with options for 
choosing default name for connection. The "Connect", "Modify connection", "Delete 
connection" and "Delete all connections" icons are provided at the top position of this 
section. 

 
 

 Note 
Connecting mapping tab 

To get a clear view of all fields in the sections within the "Connection mapping" tab, it is 
suggested to use the "Collapse" option within the Inspector window and Project tree. Once 
you click on "Collapse" icon, the window minimizes and provides with "Expand" option. At 
any point of time, to bring back the window, click on "Expand" icon.  

 

The "WinCC User Archive Provider" section consists of 3 tabs: 

● WinCC User Archive 

● Where-Statement 

● OPC 

 

 Note 
Select OPC Server 

In order to configure the settings on the "Where Statement" tab, you must have selected an 
OPC server in the dialog "Trigger Provider (Page 86)". This dialog window is accessed by 
clicking on the "Event" button in "Transfer options" tab. 

 

 

WinCC User Archive  

1. In "WinCC User Archive provider", the selected archive is shown in the "Table" field. 
Select the Schema for database if applicable by selecting from the drop down list in 
"Schema" field. 

2. The Column names are displayed within "Columns" area. Select a Column name from the 
list. The selected column is displayed in "Column for data value" field. The data type is 
shown automatically. 

3. The "Filter" field provides you the option to filter the Column names based on single 
character or first few characters of column name. 

For example, if you wish to view the column names starting with "S", type this character in 
"Filter" text box. All column names starting with "S" are displayed.  
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4. Next, configure the tag in the "OPC Data Access consumer" section by following these 
steps: 

– Select the tag name from the list that is displayed within "OPC tag browser". Upon 
selection of the tag within OPC tag browser, the tag name is displayed in "Tag ID" 
field. The data type is displayed in "Datatype" field based on selection of the tag. 

 
 
  Note 

Data type conversion 

If the provider tag data type does not match with consumer column, IDB CS converts the 
data type to match with data type of provider tag. A status window is displayed to indicate 
this change. 

 

5. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

6. Repeat steps 1 to 4 for all elements of the "WinCC User Archive Provider" that you wish 
to transfer. 

 

 Note 
Array 

If the WinCC User Archive provider tag has a data type selected other than array data type 
and if the OPC Data Access consumer tag has "Array" data type wherein the "Array" check 
box has been checked, then after clicking the "Connect" button, an error message is 
displayed. This will not allow to perform a connection mapping as "Array" data type might not 
be supported by the selected provider.  

 

 

Where Statement 

The SQL String that describes the access location for reading the data is shown on this tab. 
The "Where-statement" tab mainly includes the "WHERE" section and text area for 
displaying the "Resulting SQL-String". 

 
 

 Note 
Columns 

The Column names shown in screenshot below might vary depending on the table used 
within Where statement. 
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Follow the steps given below to configure the Where statement: 

 

1. Click "Add" button to open the dialog that provides you with options to select the column 
in order to compare the content. 

2. Select the Fieldname you wish to check for a certain value. The selected field name is 
displayed in "Fieldname" field. The data type for this field name is automatically selected 
in the "Datatype" field. 

3. This "Fieldname" is shown in the "WHERE" text box. Choose the operator symbol from 
the drop down list that is used for comparision. 

4. In "OPC-variable" section, select the OPC tag, the value of which is compared with the 
previously selected column entry. Then, click OK button. 

5. The condition is shown in the table within "Where" section and is entered in the "Resulting 
SQL String" field. 
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6. To remove an already existing "Resulting SQL String", click "Remove" button. 

7. To define multiple conditions, repeat steps 1 to 5. 

 

 Note 
SQL String 

 
• If multiple conditions are configured, they are connected with a logical "AND". 
• Only data records (lines) are requested from the IDB and transferred in which all 

conditions have been met. 
• An optional connection is not possible with a logical "OR". 

 

 

Advanced 

Using button "Advanced", you can define the sort sequence and the behavior when multiple 
data records exist. 
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● Order By 

Select the selection field. You can then define the column name and the sort direction. 

● Behavior with several results: 
Select one of the following option fields and click OK button. Based on selected radio 
button, you can decide the action to be performed: 

 

– Error message (no data transferred) 

– Submit first line 

– Submit last line 

– Submit all lines 

 

Standard settings for these options are: 

● No sorting 

● Error message (no data transferred) 

 

OPC tab 

The "OPC" tab includes options to connect OPC tag(s) that have been sent from the WinCC 
User Archive interface with OPC Data Access consumer tag(s). 
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 Note 
Select OPC Server 

In order to configure the settings on the "OPC" tab, you must have selected an OPC server 
in dialog "Trigger Provider (Page 86)". This dialog window is accessed by clicking on the 
"Event" button in "Transfer options" tab. 

 

 

 

1. In the "WinCC User Archive Provider" area, within the OPC tab, the OPC tag browser is 
displayed. In tag browser, select the tag for which the values should be transferred. The 
selected tag is shown in the "Tag ID" field. The data type is chosen according to the 
selection. 

2. If the selected tag has Array data type, then the "Array" check box is automatically 
enabled. This check box is provided below the "Datatype" field. 

3. Next, configure the consumer column in the "Database consumer" section by following 
these steps: 

– The selected table is shown in the "Table" field. Select the Schema if applicable by 
selecting from the drop down list in "Schema" text box. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 

4. Select the Column name that you wish to connect with the OPC tag. The selected column 
is displayed in "Column for data value" field. 

5. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 
 
  Note 

Data type conversion  

If the provider column does not match with consumer column, IDB CS converts the data 
type to match with data type of provider. A status window is displayed to indicate this 
change. 

 

6. Repeat steps 1 to 5 for all elements of the "WinCC User Archive Provider" that you wish 
to transfer. 
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 Note 
Array 

If the WinCC User Archive provider column has a data type selected other than array data 
type and if the OPC Data Access consumer tag has "Array" data type wherein the "Array" 
check box has been checked, then after clicking the "Connect" button, an error message is 
displayed. This will not allow to perform a connection mapping as "Array" data type might not 
be supported by the selected provider.  

 

Result 
The connections that you have created are shown in the "Connections" tab of IDB CS 
"Settings" window as well as within the project tree node. 
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5.2.5 Viewing Example 1 in WinCC Runtime 

Overview 
This chapter provides information about the steps to be followed in order to view Getting 
Started Example 1 in WinCC Runtime environment. The Getting Started project provided 
along with the installation includes all the required resources for running the example project. 

 

Prerequisites 
● WinCC V7.3 is installed 

● IDB Getting Started project "idb_getting_started.MCP" is loaded in WinCC and project is 
activated 

● IDB CS application is open 

● Getting Started project "IDBProject" is loaded in IDB CS application 

 

Importing the configuration (XML file) 
Follow the steps given below to import the configuration file provided along with IDB Getting 
Started and to configure the respective provider/consumer type: 

1. In IDB CS, select Project > Import Runtime Configuration to import the configuration file. 

2. In the "Open" dialog window displayed, browse for the IDB Getting Started folder 
(idb_getting_started) and select the configuration XML file 
"idb_getting_started_configfile.xml". Next, click "Open" button. 

3. The IDB Getting Started project configuration will be imported in IDB CS with the project 
name displayed as "IDBProject". 

4. The project tree on left hand side displays a tree structure that displays the project, links 
and their sub-nodes. 
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5. In IDB CS, perform the following settings in the respective provider/consumer modules 
that is part of Example1 project: 

– In WinCC OLEDB provider configuration, select the WinCC project XML file that you 
have exported from WinCC. 

 
 
  Note 

Reports 

After exporting the XML file from WinCC project, by default the XML file will be 
exported within the Reports folder. This folder exists within the "IndustrialDataBridge" 
folder. The Reports folder includes the exported XML file. 

 

– In WinCC OLEDB provider configuration, for use on a WinCC station, select the 
WinCC station name by selecting the drop down list in "WinCC station name" field. 

– In WinCC User Archive provider /consumer configuration, enter the complete 
computer path wherever WinCC has been installed and choose the appropriate 
database. 

– Configure the Where statement and advanced options for WinCC User Archive 
provider / consumer in connection mapping tab and create connections. 

6. After performing these steps, save the project and export the configuration XML file to the 
IDB Getting Started folder (idb_getting_started). 

This XML file will be used in IDB Runtime application. 

 

 
 

 Note 
Opening IDB configuration 

The IDB configuration required for Getting Started project can also be opened in IDB CS 
using "IDBProject.ip73" file. In IDB CS, click Project > Open project and click on Browse 
button to browse the folder structure. Select the .ip73 file existing within "IDBProject" folder 
by browsing the folder contents. 

 

Viewing Example 1 in WinCC Runtime 
The Example 1 displayed in WinCC Runtime includes several user controls and buttons that 
enables the data transfer. The text controls are provided to enter the required value in these 
these fields. The IDB Runtime control is provided in the middle of the example screen that 
includes options to connect the links and initiate data transfer. 
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Follow the steps given below to connect the configuration and start data transfer: 

1. In IDB Runtime control, select "Options" button to open the "Runtime configuration" 
window. In "NT Service" tab, click "Start service" button to start IDB Runtime service and 
click OK. 

2. Next, load the configuration XML file by clicking on the Open button. Please remember to 
choose the appropriate configuration XML file that you exported to IDB Getting Started 
folder (idb_getting_started). 

3. In the "Open" dialog window, browse the idb_getting_started folder contents and select 
the configuration file "idb_getting_started_configfile.xml". Click Open button once you 
have selected the XML file. 
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4. The list of connections will be displayed along with provider and consumer status. 

 
 
  Note 

Connections displayed in IDB Runtime 

The IDB Runtime window displays the connections (links) that belongs to both Example 1 
and Example 2. While working with each example, it is suggested to select the 
connections (links) that are used within the specific example.  

 

5. Click "Connect" button to connect the provider and consumer types. 

6. The status of provider and consumer will now be changed to green colour. Next, click 
"Start" button to start the data transfer. 

Send process values to WinCC User Archive 

7. In left hand portion of example screen, select the recipe from the list. Based on the 
selection, click "send process values" button to send the process values to WinCC User 
Archive. 

8. The user archive values will be displayed in the "WinCC User Archive" control. 

Send alarm data to CSV 

9. Enter the start date and end date in "start date" and "end date" fields as per the format 
mentioned in the example screen. 

10.Click "send alarm" button to filter the data in alarm message archive and transfer the 
filtered data to CSV file. 

Recive recipe 

11.Once data transfer is started in IDB Runtime, the ingredient values will be sent from 
WinCC User Archive to OPC Data Access. 

 

 
 

 Note 
Switching between Example 1 and Example 2 

To switch from one example to other, click the button provided at bottom right hand portion 
of the example screen. 

It is important to note that after switching to another example, before proceeding further, you 
need to stop the data transfer, disconnect the connection(s). Once you are ready, then you 
can start connecting the provider/consumer types and start the data transfer. 

 

Result 
You have performed the data transfer successfully and have understood the steps for 
connecting the configuration links and starting data transfer using IDB with the help of this 
example. 
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5.3 Getting Started Example 2 

5.3.1 Introduction 

Introduction 
This Getting Started example helps you to understand the data transfer between process 
Dynamic database to WinCC User Archive using a simple recipe example. This is shown in 
the Getting Started Example 2. 

 

This example helps you to perform data transfer based on the values you have entered. 
Further, the production results are inputted by user using the text box controls in Example 2. 
The production results can be updated to the Dynamic database. 

 

 
 

 Note 
Example project - IDBProject 

The example that includes the complete configuration provided along with Getting Started 
project contains a fully defined configuration, provider transfer options that are set along with 
connections that have already been created. 

 

 

Example 2 uses the following configuration available as links. In example 2, you will create 2 
links "Download_RecipeData" and "Upload_ProductionResult" within this example project.  

You can view this configuration in IDB CS application. 

● Dynamic Database as provider, WinCC User Archive as consumer 

● WinCC User Archive as provider, Dynamic Database as consumer 

 

 

● Dynamic Database - WinCC User Archive 

Clicking on a button transfers or retrieves ingredients for a selected recipe from the 
database into the WinCC User Archive. 

These ingredients are displayed in the "WinCC User Archive" in example screen. 

● WinCC User Archive - Dynamic Database 

Clicking on a button writes the production results (after processing the ingredients) 
entered by user to the database 
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However, in order to make you understand better, the following chapters provide information 
about the steps in detail for creating or configuring the connections. Each chapter includes a 
series of steps listed as Step 1, Step 2, Step 3 and Step 4 that guides you through the 
detailed procedure.  

● Dynamic Database - WinCC User Archive 

● WinCC User Archive - Dynamic Database 

 

 Note 
Important information  

In case you do not want to perform the steps given in above mentioned chapters, and you 
wish to view the example in WinCC Runtime directly, it is strongly recommended to perform 
the steps mentioned in the chapter "Viewing Example 2 in WinCC Runtime (Page 149)". 
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5.3.2 Dynamic Database - WinCC User Archive 

5.3.2.1 Step 1: Create Project and Link 

Introduction 
This chapter provides you with the complete steps for creating a project and link in IDB 
Configuration System application. The objective here is to create a project with 
corresponding link having Dynamic Database as provider and WinCC User Archive as 
consumer. 

Procedure 
 

1. Open IDB Configuration and create a project by following the steps mentioned below: 

 

 
– In IDB Configuration menu, select "Project" > "Create" to create a new project. 

– In the "Create new project" dialog box, specify a project name, click [...] button and 
select the folder location wherever the project needs to be saved. 

– After entering the required information, select "Create" button. This creates a new 
project. 

2. The project name will be listed within the "Project tree". 
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3. The next step is to create a link. Follow the steps mentioned below to create a link 
between provider and consumer: 

 

 
– Right click on project name node in the tree structure and select "Add new link" option. 

After creating a project, by default a new node "Add new link" is displayed in project 
tree below project name node.  

Alternatively, you can create a new link by double clicking the "Add new link" node in 
project tree. 

– In the "Add new link" dialog that is displayed, enter a unique link name. 

– Select the provider type as Dynamic Database, consumer type as WinCC User 
Archive and click OK button. 

– The created link will be displayed below the project name in project tree. 

4. The corresponding entries - Provider, Consumer, Settings and Connections are created 
as nodes that exist below the new link in the tree structure. 

 

Result 
You have created a project that consists of a link having Dynamic Database as provider and 
WinCC User Archive as consumer. 
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5.3.2.2 Step 2: Configuring an Interface 

Introduction 
In this chapter, you will configure the respective provider/consumer configuration along with 
transfer behavior settings for provider.  
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Procedure 
1. In project tree, open the Provider configuration window by double clicking the Provider 

node. 

 

 
2. In Provider configuration window, perform the following settings: 

– Select the type of database by choosing the appropriate radio button. 

– If the database exists on a server location, enter the server name in "Server" field. 

If you wish to enable windows authentication automatically, select the check box "Use 
automatic Windows authentication". 

– In "Database" field, click on [...] button and select the database from the list or from the 
folder structure. 

 
 
  Note 

Server name 

The "Server" field for entering the Server name, "Use automatic Windows 
authentication" check box and fields for entering the logon information are enabled 
only if you have selected a database other than Microsoft Access. 
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– If a user name and password has been set for the database, enter the user name and 
password in the "User name" and "Password" fields respectively. 

If you wish to set a blank password, enable the check box "Allow saving password". 

– Click Test button to test the connection. The application tests the database connection 
string and verifies the selected database. 

3. In Consumer configuration window, perform the following settings: 

 

 
– Enter the server name and/or complete path of WinCC User Archive database. 

– Select the database name from the list that is displayed in the "Database" field. Click 
on the drop down list box to view this list. 

– If you wish to enable windows authentication automatically, select the check box "Use 
automatic Windows authentication". 

– Within the section area that provides options to logon to the database, enter the user 
name and password. 

This information is required to logon to the WinCC User Archive database. 

– Click Test button to test the connection. 

 
  Note 

User Archive 

Ensure that you enter the complete path of the computer wherever WinCC has been 
installed. If the path name is not valid, then the "Database" field will not display any 
tables. Also, it is important to verify that the user archive table contains one or more rows 
of data. 
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Performing link settings 
1. In project tree, double click the Settings node to open Settings window in the work area. 

The Settings window consists of 3 tabs - Transfer options, Connection Mapping & 
Connections. 

 

 
2. Within the Transfer options tab, you can configure the transfer behavior settings for 

provider. 

 
 
  Note 

Selecting Schema 
• If you are using a database other than Microsoft Access, selection of Schema is 

mandatory before choosing the Table name. 
• While using Microsoft Access as database, the "Schema" field is displayed in disable 

state and does not allow any selection of Schema. 
 

– Select the Schema firstly (if applicable for the database) and then choose the Table 
name by selecting from the drop down list. 

– Click "Event" button to configure the trigger provider settings. The "Trigger provider" 
window will be opened. 

The description of the "Trigger provider" is provided in chapter "Configuring a Trigger 
(Page 113)". 

3. The transfer behavior settings for provider will be saved automatically. 
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 Note 
Saving changes 

A save operation is not required every time whenever changes are performed within the 
editor window in the work area. The changes made to these settings are automatically 
saved. However, once the project is created, at any point of time, you can save the project 
by selecting the "Project" > "Save" menu option. 

 

Result 
You have configured the Dynamic Database interface and WinCC User Archive as 
consumer. These elements are displayed in the tree structure of the configuration interface. 
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5.3.2.3 Step 3: Configuring a Trigger 

Introduction 
The "Trigger Provider" dialog window provides the OPC settings, Trigger configuration 
options and required fields that help you to configure the condition that triggers a data 
transfer. This dialog window is opened after clicking the "Trigger" button in Transfer options 
window. 

 
 

 Note 
OPC tag browser 

The OPC tags within "Trigger configuration" section will only be displayed if you have 
already selected the name of the OPC Server. 
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Procedure 
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1. In "OPC settings" area, select the OPC server by clicking on the [...] button. The selection 
of the server is supported by an OPC tag browser. Next, click the button representing 
"tick mark" to accept the changes. 

 

 
2. If this server is located on another computer, enter the computer name as well. The tree 

structure of OPC server is displayed within "Trigger Configuration" area. 

 
 
  Note 

Node name 

For local OPC Server, the node name will display as "local host". In case of remote OPC 
Server, the remote computer name will be displayed after selection of OPC Server on the 
remote computer. This "Node name" is required for searching the OPC Server from the 
remote computer. 

The OPC tag browser does not display any content if node name is invalid. 
 
  Note 

The "OPC Server" and "Node name" fields are provided as editable fields.  

If the information about OPC Server name and node name is known, you can directly 
enter the information in the "OPC Server" and "Node name" fields. If the node name / 
OPC Server name is invalid, there will be no content displayed within the OPC tag 
browser.  

 

 

3. You can define an OPC tag on the trigger source, in which the success-/failure-status of 
the data transfer will be stored in the "Tag for transaction security" field. This value should 
have 1 byte signed char (e.g. VT_I1). -1 indicates the success state and 0 indicates 
failure. 

Select the tag of the OPC server, in which this information is to be saved in the tag 
browser and click on the "Apply item" button. 
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4. In "Trigger Configuration" area, select the desired tags individually and accept them by 
clicking on "Add item" each time. 

The selected tags are shown in the Tag list below.  

5. Use the "Remove item" button to remove the marked item. If no item is marked for 
deletion, the last item from the list is deleted if you click the "Remove item" button. Details 
about the columns in the Tag list are located in section "Tag declaration". 

 
 
  Note 

OPC Server 

After selection of the tags and adding them to tag list, if you switch to another OPC 
Server in OPC Settings area, a dialog window is displayed that prompts the message 
whether you wish to discard previous settings. 

 

6. In "Trigger condition" area, you can select the type of syntax with selection button "VB 
Style" or JScript Style". If a trigger condition is already created, this setting can no longer 
be changed. If the language is to be changed, the text in the "Configure Trigger 
Condition" field must be deleted. 

Details on the programming languages are located in section "Programming Languages". 

7. Create the trigger condition in the selected language. Use the Alias designations in the 
tag list for these tags. Within the text box displayed, enter the operator symbols using the 
keyboard or select them from the "Logical patterns" list box. 

8. Test the created condition by clicking on "Validate". The trigger condition is calculated 
with the values that are entered in the "Test value" column. The result "TRUE" or 
"FALSE" is shown in a message box. 

9. If the trigger condition provides the correct result and after confirming the changes, close 
the dialog by clicking on "OK" button. 

Additional Information 

Tag declaration 

The columns for the tag declaration contain the following: 

 

● Data type: Data type of the tag. If the data type defined here does not match that on the 
server, an attempt to convert the data type is made. 

● TagID: The TagID of the tag on the OPC server 

● Alias: The alias is used for creating the trigger condition. This name must be unique and it 
must correspond with the naming conventions of the allocated programming languages. 
For more detailed information about the naming conventions, see paragraph "Valid alias 
names". 
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● Confirmation value: The confirmation value is the value that the variable takes on after 
fulfilling the trigger condition and the values have been delivered to the consumer. The 
default value is "<Empty>", i.e., no confirmation value is written. 

● Test value: This value is only for testing the trigger condition and has no influence on the 
later data exchange. The test values are to be selected and changed so that they test 
whether the trigger condition delivers the expected result in all operating conditions. 

 

 Note 
Confirmation value 

The confirmation value does not give any information on whether a transaction has been 
completed successfully. 

 

 Note 
Necessity of Alias names 

The OPC ItemID is not used because it may possibly not correspond with the tag validity 
criteria, for instance, a "Point" in the tag name is not allowed. 

 

 

Valid Alias names 

A valid alias must correspond with the following rules: 

● Letters (no umlaut characters or ß), numbers and underscore character (_) are allowed. 

● The first character must be a letter or underscore. 

● An alias can be as long as you require. 

● Key words from VB script or J script are not allowed. Note the respective language 
description for this. 

● Case sensitive (upper and lower case letters). 
("tag" is not the same as "Tag"). 

 

Programming languages  

You can use VBScript or JScript for the trigger condition. 

The following table shows the operator type and their symbols in both languages: 

 

 
Type VBScript JScript 
Logical NOT NOT ! 
Logical AND AND && 
Logical OR OR || 
multiplication * * 
division / / 
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Type VBScript JScript 
addition + + 
subtraction - - 
Not equal to <> != 
Less than < < 
Greater than > > 
Comparison = == 
Assignment <not possible> = 
True true or True true 
Incorrect false or False false 
string <Quotation Marks> <Quotation Marks> 

It is recommended to use these operators only. Other operators can be found in the 
language descriptions for the respective language 

 
 

 Note 
Loss of Trigger Events 

The triggering depends on the update speed of the OPC server. In this case, note that data 
changes that occur within an update cycle are not considered by the trigger. That means that 
a faster change of a tag from 1 - 0 - 1 is not necessarily indicated to the trigger provider by 
the OPC server, since the 1 exists at the end again and no value change exists at the check 
time. This means that a potentially true condition is not recognized as being true and 
therefore will not lead to a data transfer. 

 
Configurations, with which the confirmation value is to set a "true" trigger condition to "false" 
again, are not secure because of the statement above. When data changes occur too 
quickly, the "true value" may stay the same or values can be left out. 
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5.3.2.4 Step 4: Connecting Tags 

Introduction 
This chapter provides the steps for performing connection mapping between provider and 
consumer. 

Connecting Tags 
In "Settings" window, the "Connection mapping" tab includes the required fields to connect 
tags that have been sent from the Dynamic database interface with the selected data 
consumer. The Connection mapping tab divides the window into 3 sections 

● Dynamic database provider 

● WinCC User Archive consumer 

● Connection mapping settings 

 

 
 

 Note 
Select OPC Server 

In order to configure the settings in the "Where Statement" tab, you must have selected an 
OPC server in the link settings in dialog "Trigger Provider (Page 113)". This dialog window is 
accessed by clicking on the "Event" button in "Transfer options" tab. 
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Dynamic Database  

The "Dynamic database provider" section is displayed at top left portion of "Connection 
mapping" tab. This section provides you with required options to choose schema, table name 
and column names to be mapped. The "WinCC User Archive Consumer" section is 
displayed to bottom left portion of "Connection mapping" tab. This section provides you with 
required options to choose schema, table name and column names to be mapped with the 
columns existing within Dynamic Database (provider). 

The separator between the provider and consumer section provides a resize handle that 
helps you to resize the height of the section in order to view the fields within the section 
clearly.  

The "Connection mapping settings" section is displayed at right side of "Connection 
mapping" tab. This section helps you to provide a name for connection along with options for 
choosing default name for connection. The "Connect", "Modify connection", "Delete 
connection" and "Delete all connections" icons are provided at the top portion of this section. 
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 Note 
Selecting Schema 
• If you are using a database other than Microsoft Access, selection of Schema is 

mandatory before choosing the Table name. 
• While using Microsoft Access as database, the "Schema" field is displayed in disable 

state and does not allow any selection of Schema. 
 

 

The "Dynamic Database provider" section consists of 3 tabs: 

● Dynamic Database provider 

● Where-Statement 

● OPC 

 

Where-statement  
 

 Note 
Select OPC Server 

In order to configure the settings in the "Where Statement" tab, you must have selected an 
OPC server in the link settings in dialog "Trigger Provider". This dialog window is accessed 
by clicking on the "Event" button in "Transfer options" tab. 

 

 
 

 Note 
Columns 

The column names displayed as shown in screenshot might vary depending on the table that 
is being used in Where statement. 
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The SQL String that describes the access location for reading the data is shown on this tab. 
The "Where-statement" tab mainly includes the "WHERE" section and text area for 
displaying the "Resulting SQL-String".  

Follow the steps provided below to configure the Where statement: 

 

1. Within Where statement tab, click "Add" button to open the dialog that provides you with 
options to select the column in order to compare the content. 

2. Select the Fieldname you wish to check for a certain value. The selected field name is 
displayed in "Fieldname" field. The data type for this field name is automatically selected 
in the "Data type" field. 

3. This "Fieldname" is shown in the "WHERE" text box. Choose the operator symbol from 
the drop down list that is used for comparision. 

4. In "OPC-variable" section, select the OPC tag, the value of which is compared with the 
previously selected column entry. Then, click OK button. 
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5. The condition is shown in the table within "Where" section and is entered in the "Resulting 
SQL String" field. 

6. To remove an already existing "Resulting SQL String", click "Remove" button. 

7. To define multiple conditions, repeat steps 1 to 5. 

 

 Note 
SQL String 

 
• If multiple conditions are configured, they are connected with a logical "AND". 
• Only data records (lines) are requested from the IDB and transferred in which all 

conditions have been met. 
• An optional connection is not possible with a logical "OR". 

 
 

 

Advanced: 

Using button "Advanced", you can define the sort sequence and the behavior when multiple 
data records exist. 
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● Order By 
Select the selection field. You can then define the column name and the sort direction. 

● Behaviour with several results: 
Select one of the following option fields and click OK button. Based on selected radio 
button, you can decide the action to be performed: 

 

– Error message (no data transferred) 

– Submit first line 

– Submit last line 

– Submit all lines 

 

Standard settings for these options are: 

● No sorting 

● Error message (no data transferred) 

 

OPC tab 

 
 

 Note 
Select OPC Server 

In order to configure the settings on the "OPC" tab, you must have selected an OPC server 
in the link settings in dialog "Trigger Provider (Page 113)". This dialog window is accessed 
by clicking on the "Event" button in "Transfer options" tab. 

 

 

1. In the "Dynamic database provider" area, navigate to OPC tab. The OPC tab mainly 
includes the OPC tag browser and "Configure provider OPC tag" area. 

2. In OPC tag browser, select the tag for which the values should be transferred. The 
selected tag is shown in the "TagID" field. The data type is chosen according to the 
selection. 

3. If the selected tag has Array data type, then the "Array" check box is automatically 
enabled. This check box is provided below the "Data type" field. 

4. Next, configure the consumer tag in the "Database consumer" section by following these 
steps: 

– The selected table is shown in the "Table" field. The schema (if selected at provider 
side) is displayed in the "Schema" field. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 
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5. Select the Column name that you wish to connect with the OPC tag. The selected column 
is displayed in "Column for data value" field of WinCC User Archive consumer. 

6. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

7. Repeat steps 1 to 5 for all elements of the "Dynamic database" that you wish to transfer. 

 

 Note 
Array 

If the OPC provider tag has a data type of array data type and if the database consumer 
column has data type other than array data type, after clicking on the Connect buton, the 
"Array" check box in the "OPC tab" is automatically unchecked. 

 

 

WinCC User Archive consumer 
In Connection mapping tab, the WinCC User Archive consumer section is displayed at 
bottom left hand side of Connection mapping tab. This section area exists below the 
Dynamic database provider section area. The WinCC User Archive consumer includes the 
following 3 tabs: 

● WinCC User Archive consumer 

● Where-statement 

● Delete settings 

 

The WinCC User Archive consumer section provides you with required options to choose 
schema, table name and column names to be mapped with the column(s) existing within 
Dynamic database provider. A specific connection can be created between the Dynamic 
database provider column and the column (belonging to WinCC User Archive consumer) 
selected in the Where statement tab. You can create a new connection or else modify an 
existing connection to apply Where statement on the selected column. 

 

Where-statement 

The Where statement is required to be configured in order to select the column within the 
WinCC User Archive Consumer. The "Where-statement" tab mainly includes the "Where 
statement" configuration section and exception handling section. 

 

Follow the steps given below to perform a connection mapping: 

1. In the "Dynamic database provider" section, at the (top left), select the column for which 
the where statement (WinCC User Archive consumer) needs to be applied. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 
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3. In the "Where-column" field, select the column that is to be used for the Where 
Statement. If a value needs to be written to the database, this column is compared with 
the connected provider column(s). Only lines in which both values match are updated. 

4. The behavior is defined in the "Exceptional handling" section if the selection of the 
consumer row is not unique: 

– Error Message: No consumer rows lines are overwritten and an error message is 
given as an output in the trace view of IDB Runtime. 

– Change all rows: All selected consumer rows are overwritten. 

– Using the "Enable Insert" check box, you define the behavior if a line with the key 
(primary key) does not exist. If the option is selected, a new line with the respective 
key is created. 

 
  Note 

Simultaneous Utilization as Key and Consumer Column 

In order to have more setting ability with the configuration, you can use a column as a 
key column and as a target column simultaneously. Take note that this causes the 
data in the database to be inconsistent and/or future access to the WinCC User 
Archive consumer may result in errors. 

 

5. Check the name of the connection in the "Connection mapping settings" area (right). 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 

Delete settings 

With "WinCC User Archive consumer", you are able to delete data records from the User 
Archive. This requires connecting a provider column with a consumer column. If the delete 
condition has been met, the data record of the consumer column is deleted from the user 
archive. Delete has priority over "Insert" and "Update" actions. 

 

Follow the steps given below to perform a connection mapping: 

1. In the "Dynamic database provider" section, at the (top left), select the column for which 
the values should be compared. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 

3. In "Delete settings" tab, enable the "Delete possible" check box and enter a value for the 
delete column in the "Value for delete variable" field. 

If the connecting provider column takes on this value, the respective data record that 
contains this value is deleted from the User Archive based on the Where statement. 

4. Check the name of the connection in the connection area (right). Enter a unique name for 
the connection in the Connection field or use the Default name convention. Click 
"Connect" button to confirm your entries. 
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Connection mapping 
 

1. In Dynamic database provider, the selected archive is shown in the "Table" field. Select 
the Schema if applicable by selecting from the drop down list in "Schema" text box. 

2. The Column names are displayed within "Columns" area. Select a Column name from the 
list. The selected column is displayed in "Column for data value" field. The data type is 
shown automatically. 

3. The "Filter" field provides you the option to filter the Column names based on single 
character or first few characters of column name. 

For example, if you wish to view the column names starting with "S", type this character in 
"Filter" text box. All column names starting with "S" are displayed. 

4. Next, configure the consumer tag in the "WinCC User Archive consumer" section by 
following these steps: 

– The selected table is shown in the "Table" field. Select the Schema if applicable by 
selecting from the drop down list in "Schema" text box. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 

5. Select the Column name that you wish to connect with "Dynamic database" column. 

The selected column is displayed in "Column for data value" field. 

6. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 
 
  Note 

Data type conversion 

If the provider column does not match with consumer column, IDB CS converts the data 
type to match with data type of provider. A status window is displayed to indicate this 
change. 

 

 

7. Repeat steps 1 to 6 for all elements of the "Dynamic database provider" that you wish to 
transfer. 
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5.3.3 WinCC User Archive - Dynamic Database 

5.3.3.1 Step 1: Create Project and Link 

Introduction 
This chapter provides you with the complete steps for creating a project and link in IDB 
Configuration System application. The objective here is to create a project with 
corresponding link having WinCC User Archive as provider and Dynamic Database as 
consumer. 

Procedure 
 

1. Open IDB Configuration and create a project by following the steps mentioned below: 

 

 
– In IDB Configuration menu, select "Project" > "Create" to create a new project. 

– In the "Create new project" dialog box, specify a project name, click [...] button and 
select the folder location wherever the project needs to be saved. 

– After entering the required information, select "Create" button. This creates a new 
project. 

2. The project name will be listed within the "Project tree". 
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3. The next step is to create a link. Follow the steps mentioned below to create a link 
between provider and consumer: 

 

 
– Right click on project name node in the tree structure and select "Add new link" option. 

After creating a project, by default a new node "Add new link" is displayed in project 
tree below project name node.  

Alternatively, you can create a new link by double clicking the "Add new link" node in 
project tree. 

– In the "Add new link" dialog that is displayed, enter a unique link name. 

– Select the provider type as WinCC User Archive, consumer type as Dynamic 
Database and click OK button. 

– The created link will be displayed below the project name in project tree. 

4. The corresponding entries - Provider, Consumer, Settings and Connections are created 
as nodes that exist below the new link in the tree structure. 

 

Result 
You have created a project that consists of a link having WinCC User Archive as provider 
and Dynamic Database as consumer. 
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5.3.3.2 Step 2: Configuring an Interface 

Introduction 
In this chapter, you will configure the respective provider/consumer configuration along with 
transfer behavior settings for provider. 
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Procedure 
1. In project tree, open the Provider configuration window by double clicking the Provider 

node. 

 

 
2. In Provider configuration window, perform the following settings: 

– Enter the server name and/or complete path of WinCC User Archive database. 

– Select the database name from the list that is displayed in the "Database" field. Click 
on the drop down list box to view this list. 

– If you wish to enable windows authentication automatically, select the check box "Use 
automatic windows authentication". 

– Within the section area that provides options to logon to the database, enter the user 
name and password. 

This information is required to logon to the WinCC User Archive database. 

– Click Test button to test the connection. Next, double click the Consumer node in 
project tree. 

 
  Note 

User Archive 

Ensure that you enter the complete path of the computer wherever WinCC has been 
installed. If the path name is not valid, then the "Database" field will not display any 
tables. Also, it is important to verify that the user archive table contains one or more rows 
of data. 

 

3. In Consumer configuration window, perform the following settings: 
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– Select the type of database by choosing the appropriate radio button. 

– If the database exists on a server location, enter the server name in "Server" field. 

If you wish to enable windows authentication automatically, select the check box "Use 
automatic Windows authentication". 

– In "Database" field, click on [...] button and select the database from the list or from the 
folder structure. 

 
 
  Note 

Server name 

The "Server" field for entering the Server name, "Use automatic Windows 
authentication" check box and fields for entering the logon information are enabled 
only if you have selected a database other than Microsoft Access. 

 

– If a user name and password has been set for the database, enter the user name and 
password in the "User name" and "Password" fields respectively. 

If you wish to set a blank password, enable the check box "Allow saving password". 

– Click Test button to test the connection. The application tests the database connection 
string and verifies the selected database. 



 Getting Started and Examples 
 5.3 Getting Started Example 2 

WinCC/IndustrialDataBridge Getting Started 
Getting Started, 5/2014, A5E32362955-AA 133 

 

Performing link settings 
1. In project tree, double click the Settings node to open Settings window in the work area. 

The Settings window consists of 3 tabs - Transfer options, Connection Mapping & 
Connections. 

 

 
2. Within the Transfer options tab, you can configure the transfer behavior settings for 

provider. 

– Select the Table name by selecting from the drop down list. 

 
 
  Note 

Schema 
• In WinCC User Archive, a default schema is selected automatically in the Transfer 

options tab. 
 

 

3. Click "Event" button to configure the trigger provider settings. The "Trigger provider" 
dialog will be opened. 

The description of the "Config Trigger dialog" is provided in chapter "Configuring a 
Trigger (Page 135)" 

4. The transfer behavior settings for provider will be saved automatically. 
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 Note 
Saving changes 

A save operation is not required every time whenever changes are performed within the 
editor window in the work area. The changes made to these settings are automatically 
saved. However, once the project is created, at any point of time, you can save the project 
by selecting the "Project" > "Save" menu option. 

 

Result 
You have configured the WinCC User Archive interface and Dynamic Database consumer 
including the provider transfer options. These elements are displayed in the tree structure of 
the IDB configuration interface. 
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5.3.3.3 Step 3: Configuring a Trigger 

Introduction 
The "Trigger Provider" dialog window provides the OPC settings, Trigger configuration 
options and required fields that help you to configure the condition that triggers a data 
transfer. This dialog window is opened after clicking the "Trigger" button in Transfer options 
window. 

 
 

 Note 
OPC tag browser 

The OPC tags within "Trigger configuration" section will only be displayed if you have 
already selected the name of the OPC Server. 
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Procedure 
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1. In "OPC settings" area, select the OPC server by clicking on the [...] button. The selection 
of the server is supported by an OPC tag browser. Next, click the button representing 
"tick mark" to accept the changes. 

 

 
2. If this server is located on another computer, enter the computer name as well. The tree 

structure of OPC server is displayed within "Trigger Configuration" area. 

 
 
  Note 

Node name 

For local OPC Server, the node name will display as "local host". In case of remote OPC 
Server, the remote computer name will be displayed after selection of OPC Server on the 
remote computer. This "Node name" is required for searching the OPC Server from the 
remote computer. 

The OPC tag browser does not display any content if node name is invalid. 
 
  Note 

The "OPC Server" and "Node name" fields are provided as editable fields.  

If the information about OPC Server name and node name is known, you can directly 
enter the information in the "OPC Server" and "Node name" fields. If the node name / 
OPC Server name is invalid, there will be no content displayed within the OPC tag 
browser.  

 

 

3. You can define an OPC tag on the trigger source, in which the success-/failure-status of 
the data transfer will be stored in the "Tag for transaction security" field. This value should 
have 1 byte signed char (e.g. VT_I1). -1 indicates the success state and 0 indicates 
failure. 

Select the tag of the OPC server, in which this information is to be saved in the tag 
browser and click on the "Apply item" button. 
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4. In "Trigger Configuration" area, select the desired tags individually and accept them by 
clicking on "Add item" each time. 

The selected tags are shown in the Tag list below.  

5. Use the "Remove item" button to remove the marked item. If no item is marked for 
deletion, the last item from the list is deleted if you click the "Remove item" button. Details 
about the columns in the Tag list are located in section "Tag declaration". 

 
 
  Note 

OPC Server 

After selection of the tags and adding them to tag list, if you switch to another OPC 
Server in OPC Settings area, a dialog window is displayed that prompts the message 
whether you wish to discard previous settings. 

 

6. In "Trigger condition" area, you can select the type of syntax with selection button "VB 
Style" or JScript Style". If a trigger condition is already created, this setting can no longer 
be changed. If the language is to be changed, the text in the "Configure Trigger 
Condition" field must be deleted. 

Details on the programming languages are located in section "Programming Languages". 

7. Create the trigger condition in the selected language. Use the Alias designations in the 
tag list for these tags. Within the text box displayed, enter the operator symbols using the 
keyboard or select them from the "Logical patterns" list box. 

8. Test the created condition by clicking on "Validate". The trigger condition is calculated 
with the values that are entered in the "Test value" column. The result "TRUE" or 
"FALSE" is shown in a message box. 

9. If the trigger condition provides the correct result and after confirming the changes, close 
the dialog by clicking on "OK" button. 

Additional Information 

Tag declaration 

The columns for the tag declaration contain the following: 

 

● Data type: Data type of the tag. If the data type defined here does not match that on the 
server, an attempt to convert the data type is made. 

● TagID: The TagID of the tag on the OPC server 

● Alias: The alias is used for creating the trigger condition. This name must be unique and it 
must correspond with the naming conventions of the allocated programming languages. 
For more detailed information about the naming conventions, see paragraph "Valid alias 
names". 
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● Confirmation value: The confirmation value is the value that the variable takes on after 
fulfilling the trigger condition and the values have been delivered to the consumer. The 
default value is "<Empty>", i.e., no confirmation value is written. 

● Test value: This value is only for testing the trigger condition and has no influence on the 
later data exchange. The test values are to be selected and changed so that they test 
whether the trigger condition delivers the expected result in all operating conditions. 

 

 Note 
Confirmation value 

The confirmation value does not give any information on whether a transaction has been 
completed successfully. 

 

 Note 
Necessity of Alias names 

The OPC ItemID is not used because it may possibly not correspond with the tag validity 
criteria, for instance, a "Point" in the tag name is not allowed. 

 

 

Valid Alias names 

A valid alias must correspond with the following rules: 

● Letters (no umlaut characters or ß), numbers and underscore character (_) are allowed. 

● The first character must be a letter or underscore. 

● An alias can be as long as you require. 

● Key words from VB script or J script are not allowed. Note the respective language 
description for this. 

● Case sensitive (upper and lower case letters). 
("tag" is not the same as "Tag"). 

 

Programming languages  

You can use VBScript or JScript for the trigger condition. 

The following table shows the operator type and their symbols in both languages: 

 

 
Type VBScript JScript 
Logical NOT NOT ! 
Logical AND AND && 
Logical OR OR || 
multiplication * * 
division / / 
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Type VBScript JScript 
addition + + 
subtraction - - 
Not equal to <> != 
Less than < < 
Greater than > > 
Comparison = == 
Assignment <not possible> = 
True true or True true 
Incorrect false or False false 
string <Quotation Marks> <Quotation Marks> 

It is recommended to use these operators only. Other operators can be found in the 
language descriptions for the respective language 

 
 

 Note 
Loss of Trigger Events 

The triggering depends on the update speed of the OPC server. In this case, note that data 
changes that occur within an update cycle are not considered by the trigger. That means that 
a faster change of a tag from 1 - 0 - 1 is not necessarily indicated to the trigger provider by 
the OPC server, since the 1 exists at the end again and no value change exists at the check 
time. This means that a potentially true condition is not recognized as being true and 
therefore will not lead to a data transfer. 

 
Configurations, with which the confirmation value is to set a "true" trigger condition to "false" 
again, are not secure because of the statement above. When data changes occur too 
quickly, the "true value" may stay the same or values can be left out. 
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5.3.3.4 Step 4: Connecting Tags 

Introduction 
This chapter provides the steps for performing connection mapping between provider and 
consumer. 

Connecting Tags 
In "Settings" window, the "Connection mapping" tab includes the required fields to connect 
tags that have been sent from the WinCC User Archives interface with the selected 
consumer. The Connection mapping tab divides the window into 3 sections 

● WinCC User Archive provider 

● Dynamic Database consumer 

● Connection mapping settings 

 

WinCC User Archive provider  

The "WinCC User Archive Provider" section is displayed at top left portion of "Connection 
mapping" tab. This section provides you with required options to choose schema, table name 
and column names to be mapped. The "Dynamic Database consumer" section exists below 
the provider section and lists the column values that can be mapped with the columns 
existing within WinCC User Archive database. 

The separator between the provider and consumer section provides a resize handle that 
helps you to resize the height of the section in order to view the fields within the section 
clearly.  
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The "Connection mapping settings" section is displayed at right side of "Connection 
mapping" tab. This section helps you to provide a name for connection along with options for 
choosing default name for connection. The "Connect", "Modify connection", "Delete 
connection" and "Delete all connections" icons are provided at the top portion of this section. 

 

The "WinCC User Archive provider" section consists of 3 tabs: 

● WinCC User Archive 

● Where-Statement 

● OPC 

 

Where-statement 

 
 

 Note 
Select OPC server 

In order to configure the settings on the "Where Statement" tab, you must have selected an 
OPC server in the dialog "Trigger Provider (Page 135)". This dialog window is accessed by 
clicking on the "Event" button in "Transfer options" tab. 

 

 Note 
Columns 

The column names shown in screenshot might vary and is dependent on the table selected. 
 

 

The SQL String that describes the access location for reading the data is shown on this tab. 
The "Where-statement" tab mainly includes the "WHERE" section and text area for 
displaying the "Resulting SQL-String". 
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Follow the steps given below to configure the Where statement: 

 

1. Click "Add" button to open the dialog that provides you with options to select the column 
in order to compare the content. 

2. Select the Fieldname you wish to check for a certain value. The selected field name is 
displayed in "Fieldname" field. The data type for this field name is automatically selected 
in the "Datatype" field. 

3. This "Fieldname" is shown in the "WHERE" text box. Choose the operator symbol from 
the drop down list that is used for comparision. 

4. In "OPC-variable" section, select the OPC tag, the value of which is compared with the 
previously selected column entry. Then, click OK button. 

5. The condition is shown in the table within "Where" section and is entered in the "Resulting 
SQL String" field. 
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6. To remove an already existing "Resulting SQL String", click "Remove" button. 

7. To define multiple conditions, repeat steps 1 to 5. 

 

 Note 
SQL String 

 
• If multiple conditions are configured, they are connected with a logical "AND". 
• Only data records (lines) are requested from the IDB and transferred in which all 

conditions have been met. 
• An optional connection is not possible with a logical "OR". 

 

 

Advanced: 

Using button "Advanced", you can define the sort sequence and the behavior when multiple 
data records exist. 
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● Order By 
Select the selection field. You can then define the column name and the sort direction. 

● Behavior with several results: 
Select one of the following option fields and click OK button. Based on selected radio 
button, you can decide the action to be performed: 

 

– Error message (no data transferred) 

– Submit first line 

– Submit last line 

– Submit all lines 

 

Standard settings for these options are: 

● No sorting 

● Error message (no data transferred) 

 

 

OPC tab 

 
 

 Note 
OPC server 

In order to configure the settings on the "OPC" tab, you must have selected an OPC server 
in dialog "Trigger Provider". This dialog window is accessed by clicking on the "Event" button 
in "Transfer options" tab. 

 

1. In the "WinCC User Archive Provider" area, within the OPC tab, the OPC tag browser is 
displayed. In tag browser, select the tag for which the values should be transferred. The 
selected tag is shown in the "Tag ID" field. The data type is chosen according to the 
selection. 

2. If the selected tag has Array data type, then the "Array" check box is automatically 
enabled. This check box is provided below the "Datatype" field. 

3. Next, configure the consumer column in the "Dynamic Database consumer" section by 
following these steps: 

– The selected table is shown in the "Table" field. Select the Schema if applicable by 
selecting from the drop down list in "Schema" text box. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 
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4. Select the Column name that you wish to connect with the OPC tag. The selected column 
is displayed in "Column for data value" field. 

5. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

6. Repeat steps 1 to 5 for all elements of the "WinCC User Archive Provider" that you wish 
to transfer. 

 
 

 Note 
Array 

If the provider tag has a data type of array data type and if the database consumer column 
has data type other than array data type, after clicking on the Connect buton, the "Array" 
check box in the "OPC tab" is automatically unchecked. 

 

Dynamic Database consumer 
The "Dynamic database consumer" section is displayed to bottom left portion of "Connection 
mapping" tab. This section exists below the WinCC User Archive provider provider section 
area. The Dynamic Database consumer section provides you with required options to 
choose schema, table name and column names to be mapped with WinCC User Archive 
provider. 

A specific connection can be created between the WinCC User Archive provider column and 
the column (belonging to Dynamic database consumer) selected in the Where statement tab. 
You can create a new connection or else modify an existing connection to apply Where 
statement on the selected column. 

 
 

 Note 
Selecting Schema 
• If you are using a database other than Microsoft Access, selection of Schema is 

mandatory before choosing the Table name. 
• While using Microsoft Access as database, the "Schema" field is displayed in disable 

state and does not allow any selection of Schema. 
 

 

The Dynamic Database consumer consists of 2 tabs: 

● Dynamic Database 

● Where-statement 
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Where-statement 

The Where statement is required to be configured in order to select the consumer column 
within the "Dynamic database consumer" area. The "Where-statement" tab mainly includes 
the "Where statement" configuration section and exception handling section. 

 

Follow the steps given below to perform a connection mapping: 

1. In the "WinCC User Archive provider" section, at the (top left), select the column for which 
the where statement (Dynamic database consumer) needs to be applied. 

2. Upon selection, the column name is displayed in "Column for data value" field. The data 
type is selected automatically based on selection of column name. 

3. In the "Where-column" field, select the column that is to be used for the Where 
Statement. If a value has to be written to the database, this column is compared with the 
connected provider column(s). Only lines in which both values match are updated. 

4. The behavior is defined in the "Exception handling" field if the selection of the consumer 
row is not unique: 

– Error Message: No target lines are overwritten and an error message is given as an 
output in the trace view of IDB Runtime. 

– Change all rows: All selected consumer rows are overwritten. 

– Using the "Enable Insert" check box, you define the behavior if a line with the key 
(primary key) does not exist. If the option is selected, a new line with the respective 
key is created. 

 
  Note 

Simultaneous Utilization as Key and Consumer Column 

In order to have more setting ability with the configuration, a column can be used as a 
key column and as a consumer column simultaneously. Take note that this causes the 
data in the database to be inconsistent and/or future access to the dynamic database 
consumer may result in errors. 

 

5. Check the name of the connection in the "Connection mapping settings" area (right). 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 

Connection mapping 
1. In "WinCC User Archive provider", the selected archive is shown in the "Table" field. 

Select the Schema for database if applicable by selecting from the drop down list in 
"Schema" field. 

2. The Column names are displayed within "Columns" area. Select a Column name from the 
list. The selected column is displayed in "Column for data value" field. The data type is 
shown automatically. 
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3. The "Filter" field provides you the option to filter the Column names based on single 
character or first few characters of column name. 

For example, if you wish to view the column names starting with "S", type this character in 
"Filter" text box. All column names starting with "S" are displayed.  

4. Next, configure the consumer column in the "Dynamic database consumer" section by 
following these steps: 

– The selected table is shown in the "Table" field. Select the Schema for database if 
applicable by selecting from the drop down list in "Schema" field. 

– The column names are displayed within "Columns" area. If the table has columns with 
respective data types, the time stamp can also be written to the table. In this case, 
select the respective "Active" check box and select the column within "Column for 
timestamp" field. 

5. Select the Column name in "Database consumer" that you wish to connect with "WinCC 
User Archive Provider" column name. The data type of selected column will be 
automatically displayed in the "Datatype" field. 

The selected column is displayed in "Column for data value" field.  

6. Check the name of the connection in the "Connection mapping settings" area to the right. 
Enter a unique name for the connection in the "Connection name" field or use the options 
within "Default name options". Click "Connect" button to confirm your entries. 

 
 
  Note 

Data type conversion 

If the provider column does not match with consumer column, IDB CS converts the data 
type to match with data type of provider. A status window is displayed to indicate this 
change. 

 

7. Repeat steps 1 to 5 for all elements of the "WinCC User Archive Provider" that you wish 
to transfer. 

Result 
The connections that you have created are shown in the "Connections" tab of IDB CS 
"Settings" window as well as within the project tree node. 
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5.3.4 Viewing Example 2 in WinCC Runtime 

Overview 
This chapter provides information about the steps to be followed in order to view Getting 
Started Example 2 in WinCC Runtime environment. The Getting Started project provided 
along with the installation includes all the required resources for running the example project. 

Prerequisites 
● WinCC V7.3 is installed 

● IDB Getting Started project "idb_getting_started.MCP" is loaded in WinCC and project is 
activated 

● IDB CS application is open 

● Getting Started project "IDBProject" is loaded in IDB CS application 

 

 

Importing the configuration (XML file) 
Follow the steps given below to import the configuration file provided along with IDB Getting 
Started and to configure the respective provider/consumer type: 

1. In IDB CS, select Project > Import Runtime Configuration to import the configuration file. 

2. In the "Open" dialog window displayed, browse for the IDB Getting Started folder 
(idb_getting_started) and select the configuration XML file 
"idb_getting_started_configfile.xml". Next, click "Open" button. 

3. The IDB Getting Started project configuration will be imported in IDB CS with the project 
name displayed as "IDBProject". 

4. The project tree on left hand side displays a tree structure that displays the project, links 
and their sub-nodes. 

5. In IDB CS, perform the following settings in the respective provider/consumer modules 
that is part of Example2 project: 

– In WinCC User Archive provider /consumer configuration, enter the complete 
computer path wherever WinCC has been installed and choose the appropriate 
database. 

– Configure the Where statement and advanced options for WinCC User Archive & 
Dynamic database provider / consumer in connection mapping tab and create 
connections. 

6. After performing these steps, save the project and export the configuration XML file to the 
IDB Getting Started folder (idb_getting_started). 

This XML file will be used in IDB Runtime application. 
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 Note 
Opening IDB configuration 

The IDB configuration required for Getting Started project can also be opened in IDB CS 
using "IDBProject.ip73" file. In IDB CS, click Project > Open project and click on Browse 
button to browse the folder structure. Select the .ip73 file existing within "IDBProject" folder 
by browsing the folder contents. 

 

 

Viewing Example 2 in WinCC Runtime 
The Example 2 displayed in WinCC Runtime includes several user controls and buttons that 
enables the data transfer. The text controls are provided to enter the required value in these 
these fields. The example includes the process of downloading recipe data from Database to 
WinCC User Archive and further uploading production results to the Database. The IDB 
Runtime control is provided in the middle of the example screen that includes options to 
connect the links and initiate data transfer. 
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Follow the steps given below to connect the configuration and start data transfer: 

1. In IDB Runtime control, select "Options" button to open the "Runtime configuration" 
window. 

2. In "NT Service" tab, click "Start service" button to start IDB service and click OK. 
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3. Next, load the configuration file by clicking on the Open button. In the "Open" dialog 
window, browse the folder contents, select the configuration file 
"idb_getting_started_configfile.xml" and click "Open" button. 

 
  Note 

Connections displayed in IDB Runtime 

The IDB Runtime window displays the connections (links) that belongs to both Example 1 
and Example 2. While working with each example, it is suggested to select the 
connections (links) that are used within the specific example.  

 

4. The list of connections will be displayed along with provider and consumer status. The 
status is shown next to each provider/consumer as a small circle. 

5. Click "Connect" button to connect the provider and consumer types.The status of provider 
and consumer will now be changed to green colour. 

6. Next, click "Start" button to start the data transfer. 

Download recipe data 

7. Within "Download recipe data" section displayed on left hand portion of example screen, 
click "Fetch data from database" button. The data retrieved from database is displayed in 
the WinCC User Archive control. A tick mark icon is shown in the example screen to 
indicate successful data transfer. 

8. The last updated record existing within the table is shown in "Set point" and "Color" fields. 
These fields serve as an input for the production process in the plant. 

Upload production results 

9. In "Upload production results" section, enter the data in "Used material" and "Operator 
name" fields and click "Add row" button. Press the "Enter" key each time when you enter 
any data in these fields. 

You can observe that the data that is entered is displayed in the WinCC User Archive 
control. 

10.Click "Send user archive data" button to send these production results to the database. A 
tick mark icon is shown in the example screen to indicate successful data transfer. 

 

 Note 
Switching between Example 1 and Example 2 

To switch from one example to other, click the button provided at bottom right hand portion 
of the example screen. 

It is important to note that after switching to another example, before proceeding further, you 
need to stop the data transfer, disconnect the connection(s). Once you are ready, then you 
can start connecting the provider/consumer types and start the data transfer. 
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Result 
You have performed the data transfer successfully and have understood the steps for 
connecting the configuration links and starting data transfer using IDB with the help of this 
example. 
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